
INSTALLATION SETUP MANUAL

NETWORK AUDIO ADAPTERS NX-100
NX-100S

Thank you for purchasing TOA's Network Audio Adapter. 
Please carefully follow the instructions in this manual to ensure long, trouble-free use of your equipment.
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1. GENERAL DESCRIPTION

TOA's NX-100/100S Network Audio Adapter is specially developed to transmit high-quality audio signals and
such control data as serial data over IP networks such as LAN or Internet in real time.

[Audio Signal Flow Chart]

NX-100/100S

LAN / WAN

CD or other music player

Microphone

Mixer

Amplifier Speaker

Audio signal (1)

Audio signal (2)  

NX-100/100S

CD or other music player 

Microphone

Mixer

Amplifier Speaker

PC with NX-100
software installed

2. FEATURES

• Permits use of not only dedicated lines, but also the Internet, which greatly reduces operating costs when
transmitting audio signals to remote locations.

• Under peak conditions with no network delay, audio signals can be transmitted with a minimal delay of about
20 ms.

• Transmission of contact control data possible. 

• Transmission of serial data control information also possible. 

• Simultaneous bi-directional transmission of audio signals possible. 

• Simultaneous transmission of audio signals to multiple locations (up to 4 locations for unicast*1 streaming,
64 locations for multicast*2 streaming) possible.

• Enables loss-free audio signal transmission even over congested networks such as the Internet.

• The entire system can be remotely operated or managed from a single PC (personal computer) using the
supplied software program.

• Because audio transmissions can be started and finished via the unit's contact inputs, systems can be
configured even without the use of a personal computer. 

• Designed to operate on either AC or DC power source. 

*1 UNICAST: A communications method used to transmit audio data to designated addresses in a
matched ratio of 1:1. Up to 4 channels can be simultaneously transmitted.

*2 MULTICAST: A communications method used to simultaneously transmit a single audio data source to
multiple destinations.

NX-100 only

NX-100 only
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3. NOMENCLATURE AND FUNCTIONS

[Front]

1. LNK/ACT Indicator (Green)
Lights when the unit is connected to a network.
Flashes while the unit is transmitting or receiving
data.

2. FD/COL Indicator (Yellow)
Remains lit while the network is in full-duplex
communications mode.
Flashes whenever data collision is detected.

3. Input Signal Indicator (Green) 
Lights when the audio signal applied to the Audio
input terminal (19) is adjusted to a level enough
high for transmission to a network with the Input
volume control (20).

4. Input Peak Indicator (Red) 
Remains lit while the input audio signal is being
distorted.
Set the Input volume control (20) and the Input
level selection switch (21) to a proper position
according to the input signal level.

5. Status Indicator (Yellow)
Remains lit during broadcasts.
Flashes while the unit is writing data into the
internal storage medium (flash memory).

6. Error Indicator (Red)
Lights if an error is detected during transmission,
etc.

7. Run Indicator (Green)
Remains lit during normal operation.
Flashes at 2-second intervals when a failure is
detected.

8. Reset Button
Restarts the unit when pressed.

9. MAC Address
The unit's MAC address consists of 12 hyphenated
alphanumeric characters.

NX-100S only

NX-100S only
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9

• NX-100S

• NX-100



1-4

Chapter 1:  BEFORE INSTALLATIONS AND SETTINGS

[Rear]

10. Cord Clamp
Pinches and securely holds the AC adapter cord
to prevent its plug from detaching. 

11. DC Power Input Terminal [DC INPUT]  

A 24 V DC input.

12. Functional Earth Terminal [SIGNAL GND]

Hum noise may be generated when external
equipment is connected to the unit. 
Connecting this terminal to the functional earth
terminal of the external equipment may reduce
the hum noise.
Note: This terminal is not for protective earth.

13. AC Adapter Terminal 
[NX-100: AC ADAPTER, NX-100S: DC INPUT]
Connect the AC adapter*1 to this terminal.
*1 Use the AD-246 (optional) or its equivalent.

14. Network Connection Terminal [10/100M]
Connects to 10/100 Base-T networks. (RJ-45
Ethernet jack)

15. RS-232C Terminal 
A 9-pin D-sub connector (male).

16. Control Output Terminal [CONTACT OUTPUT]
An open collector output (Withstand voltage: 30 V
DC, Control current: 50 mA maximum). 

17. Control Input Terminal [CONTACT INPUT]
A no-voltage "make" contact input (Short circuit
current: 10 mA, Open voltage: 12 V). 

18. Audio Output Terminal [AUDIO OUTPUT]
A 0 dB*2/10 kΩ balanced output. Line level audio
signal output.
H: Hot
C: Cold
E: Ground (shield)

19. Audio Input Terminal [AUDIO INPUT]
A –58 to 0 dB*2/2 kΩ balanced input. Microphone
or line level audio signals can be connected to
this terminal.
H: Hot
C: Cold
E: Ground (shield)

*2 0 dB = 0.775 V

NX-100 only

NX-100S only

NX-100 only
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GND 10/100M
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AC ADAPTER
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• NX-100



1-5

Chapter 1:  BEFORE INSTALLATIONS AND SETTINGS

20. Input Volume Control [INPUT VOLUME]
Adjusts the audio input level. 
Turn the control clockwise to increase the level
and counterclockwise to decrease it.

Adjust the control so that the Input signal
indicator (3) lights and the Input peak indicator
(4) does not light.

21. Input Level Selection Switch [LINE/MIC]
Set this switch to the MIC (right side) position
when using a microphone, and to the LINE (left
side) for other inputs. (Factory-preset to the LINE
position.)

22. Phantom Power ON/OFF switch [PHANTOM]

The supply voltage is 24 V DC.
To supply the phantom power to the microphone
connected to the Audio input terminal (19), set
the Input level selection switch (21) to the MIC
position and the PHANTOM switch to the ON
position.

NX-100S only

NX-100S only



1-6

Chapter 1:  BEFORE INSTALLATIONS AND SETTINGS

4. SETTING TASK FLOWS

(1) Unit Installation and Connection

Refer to Chapter 2, Unit and Software Installations.

(2) Software Installation

Install the setup program, operation program, and Java Runtime Environment in the personal
computer (PC).

• The setup program can perform settings for multiple NX-100 and NX-100S units connected to the
same network.

• The operation program enables the PC to remotely operate the network PA system to make
broadcasts.

• Both the setup and operation software programs are written in the Java programming language. To
use them, install Java Runtime Environment.

Note
Refer to p. 2-8, Software Installation, for the installation procedure.

(4) Operation-Related Settings

The NX-100 Operation Program is required to make broadcasts from the PC. The Operation Program
performs settings using the setting data prepared in (3) System Setting above.

Note
Refer to Chapter 5, Operation Settings (NX-100 Operation Program), for the setting procedure.

(3) System Setting

There are two setting methods:

1. Setting Using NX-100 Setup Program
This method permits integrated settings and management of the entire system by automatically
scanning the NX-100 and NX-100S units connected to the LAN.

Note
Refer to Chapter 3, System Settings (NX-100 Setup Program), for the setting procedure.

2. Setting Using Browser
Individual settings can be performed using Internet Explorer or a similar browser, which comes
standard-installed in most PCs, without having to install the software program anew. Use the browser
for setting any NX-100 and NX-100S units connected to the Internet using the NAT function.

Note
Refer to Chapter 4, System Settings (Setting Using Browser), for the setting procedure.
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1. CONNECTIONS

1.1. Power Source Connections

1.1.1. When using a 24V DC power source 

Connect a 24V DC power source to the unit's DC INPUT terminal.

NX-100 only

To 24V DC power source

24V  
DC INPUT

FG
  200mA

10/100M

AC ADAPTER

24V      200mA
DC INPUT

Notes
• Be sure to connect the unit's FG terminal to the

ground terminal of the amplifier or mixer.

• The DC power supply must have a capacity of
over 200 mA.

• The range of input voltage to be fed to the DC
INPUT terminal should be between 21.6 V and
26.4 V DC. If the input voltage exceeds this range,
the unit may malfunction or fail.

• Refer to p. 2-5, CONNECTIONS TO TERMINAL
PLUGS, for connector connection procedures. 

1.1.2. When using the AC adapter

Connect the AC adapter* to the unit's AC adapter terminal. Pinch the cord with a clamp and securely fix it. 

* Use the AC adapter AD-246 (optional) or the equivalent. As for the usable adapter, consult your TOA dealer.

Cord clamp

AC adapter

SIGNAL
GND 10/100M

DC
24V 200mA

INPUT

Ferrite clamp (supplied with the NX-100S only)

This figure represents the NX-100S.

Note
When noise interference affects voice output, connecting
the unit's Earth terminal (FG terminal for the NX-100,
SIGNAL GND terminal for the NX-100S) to the ground
terminal of the connected amplifier or mixer may improve
the condition.

1.1.3. When simultaneously using the 24V DC power supply and the AC adapter 

When both the 24 V DC power supply and the AC adapter are simultaneously used, the AC adapter takes
precedence. However, should power from the AC adapter be interrupted due to a power failure, etc., the
power supply will automatically switch over to the unit's 24 V DC power source. Connecting a battery directly
to the DC INPUT terminal also permits it to be used as backup power supply during a power failure.

NX-100 only

Mount the ferrite clamp (supplied with the NX-100S) on the cable in a way that the cable is looped
one turn as illustrated. (This countermeasure is for complying with the CE marking requirements.)
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1.2. Terminal Connections

MICLINE

VOLUME
INPUT

24V
DC INPUT

AUDIO OUTPUT

FG

76

76

AUDIO INPUT

8 C54321

C854321

CONTACT OUTPUT

CONTACT INPUT

RS-232C
200mA

10/100M

H C E

H C E

AC ADAPTER

24V      200mA
DC INPUT

• Audio Input Terminal Connections

  Connect the microphone or other sound 

  sources using 2-core shielded cable.

• Audio Output Terminal Connections

  Connect the mixer, amplifier, etc. using 2-core 
  shielded cable.

• Network Connections 

To microphone or 
other sound sources 

To mixer, amplifier, etc.

H C E

H C E

The NX-100/100S automatically distinguishes between 10BASE-T and 100BASE-TX networks, and 
establishes a connection. For this connection, use a "straight" UTP Category 5 LAN (Ethernet) cable 
fitted with an RJ-45 connector.

Tip
It is recommended that the unit be connected to network equipment capable of performing full-duplex 
communications.

When the connected unit has an unbalanced input, make the connections 
as follows:

NX-100/100SConnected Unit H
E

Hot (H)
Cold (C)
Earth (E)

Shield Shield

This figure represents the NX-100.

Note
Refer to p. 2-5, CONNECTIONS TO TERMINAL PLUGS, for audio terminal connection procedures.
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MICLINE

VOLUME
INPUT

24V
DC INPUT

AUDIO OUTPUT

FG

76

76

AUDIO INPUT

8 C54321

C854321

CONTACT OUTPUT

CONTACT INPUT

RS-232C
200mA

10/100M

H C E

H C E

AC ADAPTER

24V      200mA
DC INPUT

76 8 C542 31

76 C854321

 Open collector output
 Withstand voltage: 30 V DC
 Control current:      50 mA maximum
 Pulse width:           1 s (when in Latch mode)

[Control Output Specifications]

To other unit's control input

• Control Output Terminal Connections

Connect the control input terminals of all other 
connected units using 2 control lines.

Caution
Be sure to connect only these 
control lines to other unit's control 
input terminals.
Connecting in parallel with control 
lines from other equipment may 
cause the unit to malfunction.

This figure represents the NX-100.

CONTACT
OUTPUT

1 – 8

C

+24 V DC

External 
power supply

Relay

Diode

GND

Note
To control a power distributor or PA 
amplifier mounted in the same rack 
as the unit using the unit's control 
output terminals, provide an external 
relay and power supply as shown 
below to perform control with the 
relay contacts.

 No-voltage "make" contact input
 Short circuit current: 10 mA
 Open voltage:           12 V
 Pulse width:              Over 50 ms

[Control Input Specifications]
To other unit's 
control output

• Connections to the Control Input Terminal 

Connect the control output terminals of all other 
connected units using 2 control lines.

• RS-232C Interface Connections 

The NX-100 can be used to control such RS-232C 
components as DTE and DCE components over a 
network. 
Use a "straight" cable fitted with a 9-pin D-sub 
connector when connecting to DTE components 
such as PCs. 
Use a "cross" cable fitted with a 9-pin D-sub 
connector for connecting to DCE components such 
as modems.

NX-100 only

Tips
• Refer to p. 2-5, CONNECTIONS TO TERMINAL PLUGS, for control terminal connection procedures.

• When not using the RS-232C interface, place the supplied RS-232C cover over the terminal to protect it
against dust. NX-100 only
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2. CONNECTIONS TO TERMINAL PLUGS

Wire the removable terminal plugs for power input (NX-100 only), audio input and output, and control input
and output as follows:

[Cable size and width to strip]

15 mm

7 mm

7 mm

Solid cable and stranded cable

Shielded cable

Application Size Width to Strip

For power supply terminal

For audio terminal

For control terminal

AWG24 – 12

AWG28 – 16

NX-100 only

Caution
Avoid soldering stranded or shielded cable, as contact resistance may increase when the cable is tightened
and the solder is crushed, possibly resulting in an excessive rise in joint temperatures.

[Wiring procedure]

Step 1. Wiring the supplied removable
terminal plug.

1-1. Loosen the terminal screws to insert
the wire.

1-2. Tighten the terminal screws.
Ensure that the wire does not break
free when pulled. If the wire does pull
free, repeat the connection procedure
from the start.

Step 2. Insert the wired terminal plug into the
corresponding terminal block in the
unit's rear panel.

Step 3. Tighten the fixing screws. 

Cautions
• Do not reverse Steps 1 and 2. Poor contact may result if force is applied to the unit's internal circuit board

pins while the terminal screws are being tightened.

• Use an appropriate type screwdriver for terminal plug wiring.

NX-100 only

AUDIO OUTPUT

AUDIO INPUT

H
C

E

H
C

E MIC

LINE

VOLUME

INPUT

Removable 
terminal plug 

1

2

3
NX-100 rear panel

Tighten

Tighten

This figure represents the NX-100.
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3. RACK MOUNTING

Use the optional mounting hardware set when installing the unit in an equipment rack. Be sure to remove the
rubber feet located on the unit's bottom surface before mounting.

• Use the optional MB-15B-BK hardware set when mounting a single unit.

00-05-F9-FF-80-81

NETWORK AUDIO ADAPTER NX-100S

LNK/ACT
FD/COL

SIGNAL

INPUT

PEAK

STATUS
ERROR

RUN

RESET

NX-100/100S

M3 x 10 machine screw*2 
(supplied with NX-100/100S)

M3 x 10 machine screw*2

(supplied with NX-100/100S)

Rack mounting bracket*1

Blank bracket*1

Fiber washer (for M5)*15 x 12 rack mounting screw*1

3 x 4 tapping screw*1

00-05-F9-FF-80-81

NETWORK AUDIO ADAPTER NX-100S

LNK/ACT
FD/COL

SIGNAL

INPUT

PEAK

STATUS
ERROR

RUN

RESET

00-05-F9-FF-80-81

NETWORK AUDIO ADAPTER NX-100S

LNK/ACT
FD/COL

SIGNAL

INPUT

PEAK

STATUS
ERROR

RUN

RESET

NX-100/100S

NX-100/100S

M3 x 10 machine screw*2 
(supplied with NX-100/100S)

 M3 x 10 machine screw*2

 (supplied with NX-100/100S)

Rack mounting bracket*1

Fiber washer (for M5)*1

Coupler*1

5 x 12 rack mounting screw*1

M3 x 6 oval head screw*1

• Use the optional MB-15B-J hardware set when mounting 2 units.

*1 Component parts of MB-15B-BK

*2 Note
Never use the screws supplied with the
MB-15B-BK to mount the bracket. 
The screws supplied with the MB-15B-BK
are so long as to damage the internal
parts, possibly causing the unit to fail.

*1 Component parts of MB-15B-J

*2 Note
Never use the screws supplied with the
MB-15B-J to mount the bracket. 
The screws supplied with the MB-15B-J
are so long as to damage the internal
parts, possibly causing the unit to fail.
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4. MAC ADDRESSES AND INSTALLATION LOCATIONS

When making the unit's network settings, the unit's MAC address* must have a clear association with its
corresponding installation location. Be sure to record the relationship during installation to facilitate later
network settings.

* A 12-digit hexadecimal address number peculiar to and assigned to the network-connected unit.

00-05-F9-FF-80-81

NETWORK AUDIO ADAPTER NX-100

LNK/ACT FD/COL STATUS ERROR RUN RESET

MAC address

This figure represents the NX-100.
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5. SOFTWARE INSTALLATION

5.1. System Conditions

The following minimum PC (personal computer) specifications are required in order to correctly operate the
unit's software program.

5.2. Activating the Setup Launcher

The Setup Launcher is automatically started when the supplied CD-ROM is inserted into the PC's drive.

Note
The Setup Launcher will not be automatically activated when the CD-ROM is inserted if the PC's CD drive is
not compatible with an auto-run function. In such cases, execute the "Setup Launcher" file below using
"Explorer" or "My Computer" or select Start → Run on the taskbar to enter the command below:

<Drive in which a CD is inserted> \Autorun.exe
[Example] When a CD is inserted into drive e → e:\Autorun.exe

• OS: Windows 2000/XP/Vista/7
• CPU: Pentium 1 GHz or greater
• RAM: 1 GB or greater
• Disk Space: 40 MB or greater
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5.3. Installing Java Runtime Environment

The following procedures do not need to be carried out if J2SE Runtime Environment 5.0 Update 3 or later
has already been installed in the PC.

Note
To download Java Runtime Installer, be sure to connect the PC to the Internet.

Step 1. Quit other activated applications before installation.

Step 2. Click "Java Runtime Environment" of the Setup Launcher.
Then, you can access the Java download site.

Step 3. Download Java Runtime Installer on the displayed download page, then run it on the PC.

Setup - Complete

You have successfully installed java.

Java updates will automatically be downroaded to provide you with the latest 
features and security improvements. To change this, see
http://java.com/autoupdate

Close

The "You have successfully installed Java."
indication will be displayed upon installation
completion.

Setup - Welcome

Welcome to Java TM

Java provides safe and secure access to the world of amazing Java contact.
From business solutions to helpful utilities and entertainment, Java makes 

your internet experience come to life.

Note: No personal information is gathered as part of our install process.
Click here for more information on what we do collect.

Click install to accept the license agreement and install Java now.

Install >CancelChange destination folder

Step 4. Accept the license agreement, then click the
"Install" button.
Installation will begin and the progress status
appears.
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Tip
Check the correct Runtime installation or version number from "Control Panel."

Installation completion icon
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5.4. Installing the NX-100 Software

The NX-100 software consists of the following 2 programs.

• NX-100 Setup Program (Installation Setting)
Enables integrated setting of the NX-100 and NX-100S from the PC.

• NX-100 Operation Program
Enables integrated setting of the NX-100 and NX-100S from the PC for broadcast activation.
Install this software program to operate the unit from the PC. 

5.4.1. Installation procedures

Step 1. Click "NX-100 Software" in the Setup Launcher.
The installer will be activated.
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Step 3. When installing in a different folder from the one displayed, press the Change button to select the
desired folder. Press the Next button if the currently displayed folder is correct. 
The "Setup Type" screen will be displayed.

Step 2. Click the Next button.
The screen "Destination Folder" will be displayed.



2-13

Chapter 2:  UNIT AND SOFTWARE INSTALLATIONS

Step 4. Select the NX-100 software program to install, then press the Next button.

Tip
When installing simultaneously the NX-100 Setup Program (Installation Setting) and Operation
Program, select "NX-100 Software Custom-Setup."

[If something other than NX-100 Software Custom-Setup is selected]
Installation will begin.

[If NX-100 Software Custom-Setup is selected]
The screen for selecting the software program to install in Custom Setup mode is displayed.

4-1. Click the icon to select software program. 
The popup menu for selecting the installation method will be displayed.

4-2. Select "This feature will be installed on local hard drive." for the software program(s) to be installed,
and "This feature will not be available." for  software program(s) not to be installed.

4-3. Press the Next button. 
Installation will begin.
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Step 5. Press the Finish button when the indication "InstallShield Wizard Completed" is displayed after
installation completion.

Tip
An icon for the installed NX-100 software program is created on the desktop.

NX-100 Setup Program (Installation Setting):

NX-100 Operation Program:

5.4.2. Update information

• The latest versions of the following software and manuals are open to the public on the Toa's download site
http://www.toa-products.com/international/: NX-100 firmware, NX-100 software (Setup program and
Operation program), and Instruction manuals (Installation setup manual and Operations manual). Please
download them from the above web site.

• To confirm the NX-100 software version, use the Help menu of the software.

• The version of each instruction manual is in the lower right corner on the last page expressed in a year-
month format. Example: "200406" represents 2004, June.



2-15

Chapter 2:  UNIT AND SOFTWARE INSTALLATIONS

5.4.3. Installation folder configuration

The NX-100 software is saved by default in C:\Program Files\TOA\NX-100.
Shown below is the NX-100 folder (Installation folder) configuration.

(Installation folder)

jh.jar

nx100_control.jar (Operation Program)

nx100_util.jar (Setup Program – Installation Setting)

nx_help.jar

packetaudio.jar

NX-100

Data in the data folder are commonly used by both the Setup Program and the Operation Program. The Setup
Program and the Operation Program always operate based on the unit setting files in the data folder.
Manually opening or saving these files cannot be performed.
Do not change the configuration or name of the file or folder in the installation folder.
When creating other systems or saving backup copies, copy the data folder into other location and save it. (To
reuse, replace the data folder with the one in use.)

5.5. Uninstalling Each Software

Select [Control Panel] → [Add/Remove Programs] to delete.

(Data folder)

Config (folder to store unit setting files) [IP address].cfg (unit setting file)

Log (folder to store logs)

panel.nxc (operation program system file)

system.nxc (setup program system file)

[IP address].log (unit operation log file)

NX-100

The system setting files are saved by default in the following locations.

• In the case of Windows 2000/XP
C:\Documents and Settings\All Users\Application Data\TOA\NX-100

• In the case of Windows Vista/7
C:\ProgramData\TOA\NX-100

Shown below is the NX-100 folder (Data folder) configuration. The Unit setting files and Setup program
system file are created after setting completion on the Setup program, the Operation program system file after
setting completion on the Operation program, and the Unit operation log file at the log file download on the
Setup program.
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1. GENERAL DESCRIPTION

1.1. What is the NX-100 Setup Program?

This program is used to set all the NX-100 and NX-100S units connected to a LAN. It also provides a simple
display on the PC screen of operating data for multiple NX-100 and NX-100S units connected to a LAN. 
Its main features are as follows:

• Scans and displays all NX-100 and NX-100S units connected to a LAN.
• Automatically sets IP addresses without duplication. Permits manual changes as well. 
• Permits simultaneous uploading of setting files to two or more NX-100 and NX-100S units.
• Backs up setting files for two or more NX-100 and NX-100S units in a batch.
• Easily and efficiently performs broadcast settings between units.

Note
When setting the unit connected to the Internet, refer to Chapter 4, System Settings (Setting Using Browser).

1.2. About Network Settings

Follow the instructions of the network management personnel before performing network settings for the PC
and connected units. Incorrect settings may adversely influence other units connected to the same network.

1.3. Backing-Up Setting Files

Setting contents, once saved, are saved in the Setup program's data folder as a unit setting file. If uploaded,
these files are stored in each NX-100 and NX-100S as unit setting files. It is highly recommended that all
settings be backed up. Backing up settings to other locations on the PC hard drive or to external storage
devices facilitates restoration should the NX-100, NX-100S or PC inadvertently fail. To save backup copies,
copy the Setup program's entire data folder. 

Caution
When settings are changed, be sure to update the backup files as well.

1.4. Cautions Concerning Setting Updates

Never restart the NX-100 and NX-100S units nor turn off their power supply while updating* the setting
contents.

* The Status indicator on the unit's front panel flashes during an update.
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2. SETUP SOFTWARE CONFIGURATION AND SETTING ITEMS

The Installation Setting Program permits settings of all items including unit scanning and network setting. First
set all items using this software at the time of system installation. The following two tools are made available:

[Unit Scanning Tool]
Performs unit scanning and network settings. Using this tool, first scan the NX-100 and NX-100S units
connected to the LAN for the system initial setting. 

[System Setting Tool]
Performs settings of unit broadcast, contact, serial bridge, etc. It is possible to create the system setting file
beforehand by entering a unit setting before installation. 

Setting Item

Unit Scanning Tool Unit scanning (See p. 3-10)

IP address (See p. 3-11)

Subnet mask (See p. 3-12)

Default gateway (See p. 3-12)

System Setup Tool Network (See p. 3-16)

Broadcast spec (See p. 3-18)

Broadcast pattern (See p. 3-20)

Contact (See p. 3-23)

Serial bridge (See p. 3-27)

System (See p. 3-29)

NX-100 only

Setting items table
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3. SETTING PROCEDURE

Pattern 1: Initial On-Site Setup

(1) Unit Scanning (Network Setting)

• After scanning the unit using the Setup program's Unit Scanning Tool, set the IP address, default
gateway, subnet mask, and unit name.

• Upload the network setting data.

• Save the network setting data in unit setting file format ([IP address].cfg).

(2) System Setting

Set non-network items using the System Setting Tool.
Manually add any units that could not be scanned, and enter their IP addresses and unit names.

Set the following items in the order listed:

• System: Set audio I/O unit names.

• Network: Set the port number.

• Broadcast Spec: Perform Broadcast Spec settings based on the network configuration. 
Before using this function, confirm the following information with network
management personnel:

· Usable bandwidth
· Whether or not multicast streaming can be used

• Broadcast Pattern: Set the units to be connected in each broadcast pattern when activated by
contact or the Operation program. (This setting not needed for units that will not
be used in broadcast patterns.)

• Contact: Set the broadcast pattern to be activated when a contact is received, and the
contact output for other connected units. Also, set the operation to be
performed when contact output is activated by other units.

• Serial Bridge :  Set the units to be connected and their serial ports when using the
serial bridge function.

NX-100 only

(3) Setting Upload

Upload the unit setting file in order to enable the settings set in Step (2) above.
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Pattern 2: Uploading the programmed system setting file after scanning the
connected units on-site.

(1) System Setting

Using the System Setting Tool, program all the units in the system, and enter their unit names and IP
address numbers.

• System: Set audio I/O unit names.

• Network: Set the port number.

• Broadcast Spec: Perform Broadcast Spec settings based on the network configuration. 
Before using this function, confirm the following information with network
management personnel:

· Usable bandwidth
· Whether or not multicast streaming can be used

• Broadcast Pattern: Set the units to be connected in each broadcast pattern when activated by
contact or the Operation program. (This setting not needed for units that will not
be used in broadcast patterns.)

• Contact: Set the broadcast pattern to be activated when a contact is received, and the
contact output for other connected units. Also, set the operation to be
performed when contact output is activated by other units.

• Serial Bridge :  Set the units to be connected and their serial ports when using the
serial bridge function.

NX-100 only

(2) Saving Data Files

Save the Setup program's data folder to the PC's hard disk drive or a connected external storage
device. Also be sure to save backup copies.

(3) Unit Scanning (Network Setting)

• After installing the system's Setup program on-site, copy the contents of the data folder saved in
Step (2) above to the data folder.

• After setting the network using the Unit Scanning Tool, upload the unit setting file using the System
Setting Tool.

Important
When performing settings according to this procedure, the pre-programmed set system setting contents are
erased if [Save in setting file format] is executed using the Unit Scanning Tool. To prevent this, take the
following precautions:

1. After completing settings using the System Setting Tool, copy and save the data folder under a
different name. 
If a data folder copy is saved, even when [Save in setting file format] is selected, it is possible to write the
unit setting file into the NX-100 and NX-100S after recopying the previously saved and renamed folder to
the data folder. 

2. After performing settings using the Unit Scanning Tool, use the System Setting Tool only after
uploading the settings, but without executing [Save in setting file format]. 
This prevents the unit setting file in the data folder from being overwritten.



3-6

Chapter 3:  SYSTEM SETTINGS (NX-100 SETUP PROGRAM)

4. STARTUP OF INSTALLATION SETTING PROGRAM

Step 1. Either double-click on the Installation Setting Program icon that was created on the desktop during
installation or directly double-click on the application [nx100_util.jar] installed in the Software folder.
The User Authentication dialog will be displayed.

Step 2. Enter the system name and password, then press the OK button.

Note: Both the system name and password are case-sensitive.

The default system name is factory-preset to "NX-100" and the password to "guest."
To change them, refer to p. 3-31.

When the system name and password are entered correctly, the initial Installation Setting Program
screen is displayed.

Tip
At startup, the Setup program automatically loads data related to unit setting from the data folder.

Step 3. When scanning the unit, click on [Unit Scan (Network Setting)].

Tip
When the settings are saved, a unit setting file is automatically created for each individual IP address
and saved in the data folder. If a unit setting file of the same name already exists in the data folder, it
is overwritten.
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Step 4. Click on [System Setting] when performing such system settings as broadcast configuration.

Tip
When the settings are saved, a unit setting file is automatically created for each individual IP address
and saved in the data folder. If a unit setting file of the same name already exists in the data folder, it
is overwritten.

Step 5. Click on [Password Change] to change the password.

Step 6. Click on [End] to exit the program.
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5. UNIT SCANNING TOOL

Scans the units connected to the LAN.
Setting data can only be uploaded into the NX-100S and NX-100 units after each unit's IP address has been
correctly set by way of either the Installation Setting Program's Unit Scanning Tool or a browser.

5.1. Screen Description

Click on [Unit Scan (Network Setting)] on the initial screen. 
Shown below is an example of the screen displayed after the units have been scanned. 

(1) Scanned unit list
A list showing the units scanned.

(2) MAC address
Displays the MAC addresses of the units
scanned.
Cannot be changed.

(3) Unit type
Displays either type of unit NX-100 or NX-100S.

(4) IP address
Displays the IP addresses of the units scanned.

(5) Subnet mask
Displays the subnet mask to be set for the units
scanned.

(6) Default gateway
Displays the default gateway to be set for the
units scanned.

(7) Web port
Displays the port number of the web server.

(8) Name
Displays the names of the units scanned.

Note
When selecting a unit, tick the leftmost checkbox in the scanned unit list.
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5.2. Menu

5.2.1. File

Save in setting file format (Ctrl+S): Saves scanned unit data to the PC in unit setting file format ([IP
address].cfg)

Exit: Exits the program.

Important
The [Save in setting file format] function is used to set broadcasts in the system settings after the unit scan is
complete. Selecting [Save in setting file format] writes the setting contents into the data folder. The contents of
the unit setting file include only the IP address, subnet mask, default gateway, unit name, and Web server port
number.
When broadcast contents have previously been set and saved using the System Setting Tool, these earlier
system settings will be erased if [Save in setting file format] is selected. 
If system setting has already been performed, take the following measures to prevent erasure of the setting
contents:

1. Upon completion of System Setting Tool settings, copy and save the data folder under a different
name. 
If the data folder is copied, the unit setting file can be written into the NX-100 and the NX-100S after
copying the renamed folder to the data folder, even when [Save in setting file format] is selected.

2. After Unit Scanning Tool settings have been performed, use the System Setting Tool after
uploading the settings, but without executing [Save in setting file format]. 
This prevents the unit setting file in the data folder from being overwritten.

5.2.2. Scan

Unit scan: Scans the units connected to the LAN.

Change settings: Uploads the settings of the selected unit.

IP address: Automatically assigns an IP address and performs related settings.
Auto assignment: Automatically assigns an IP address to the selected unit.
Assignment range setting: Sets the IP address range to be used in automatic IP address assignment.

Subnet mask setting: Sets the same subnet mask to the selected units.

Default gateway setting: Sets the same default gateway to the selected units. 

Select all (Ctrl+A): Selects all of the units scanned.
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5.2.3. Help

Help: Displays help contents.

Version data: Indicates the version of the program in use.

5.3. Buttons

(1) (2)

(1) Unit scan button: Scans all the units on the LAN. 

(2) Setting upload button: Writes the IP address, subnet mask, default gateway, and name into the selected
units. 

5.4. Scanning Units

Scans each unit connected to the LAN.

Step 1. Connect NX-100 and NX-100S units to the network and turn on each power. 
The LNK/ACT Indicator will light.

Step 2. Either press the Unit Scan Button or select [Scan] → [Unit scan].
The MAC address, IP address, subnet mask, default gateway, and unit name of the NX-100 and
NX-100S connected to the LAN will be displayed.
Default values are factory-preset as follows:

IP address: 192.168.1.1
Subnet mask: 255.255.255.0
Default gateway: 0.0.0.0
Name: NX-100S or NX-100

Caution
Units can only be scanned within the effective broadcast range. (See p. 6-3.)
For the units that cannot be scanned, manually add only the units connected to the LAN with the System
Setting Tool.
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5.5. Changing the Unit Setting Values

Change the unit's setting values individually. 

Step 1. Double-click on the desired cell.
Data can be entered.

Step 2. Enter a new value.

Step 3. Press the Enter key or click on another cell.

Step 4. After editing completion, press the Upload Button .

Caution
Since the NX-100 and NX-100S units are automatically reset after uploading, any broadcasts currently in
progress are stopped.

5.6. Automatic IP Address Assignment

Set the IP address for the unit scanned.
Besides the "Changing the Unit Setting Values" method described in the previous item, there is another
method for automatically assigning addresses by limiting the IP address setting range.

Step 1. Select the unit to which the address is assigned by ticking its selection checkbox. 
To assign the same address to all units, select [Scan] → [Select all].

Step 2. Select [Scan] → [IP address] → [Assignment range setting] to set the usable IP address range. 

Setting the range permits the selection of [Scan] → [IP address] → [Automatic assignment].

Step 3. Select [Scan] → [IP address] → [Automatic assignment]. 
The IP addresses are automatically assigned without duplicating. 
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5.7. Subnet Mask and Default Gateway Settings

The same subnet mask and default gateway numbers can be set for all selected units. 

Step 1. Tick the selection checkbox to select the unit. 
To select all units, select [Scan] → [Select all].

Step 2. Set the subnet mask.

2-1. Select [Scan] → [Subnet mask setting].

2-2. A dialog will be displayed. Enter the setting value and click on the OK button.

Step 3. Set the default gateway.

2-1. Select [Scan] → [Default gateway setting].

2-2. A dialog will be displayed. Enter the setting value and click on the OK button. 
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6. SYSTEM SETTING TOOL

Setting data can only be updated after the unit's IP address has been correctly set by way of either the
Installation Setting Program's Unit Scanning Tool or a browser.

6.1. Screen Description

Clicking on [System Setting] on the Installation Setting Program's initial screen displays the following window.
If the unit to be set is selected, its currently set contents are displayed in the right-side setting form.

(1) Name
Displays the unit names programmed into the system.

(2) IP address
Displays the unit IP addresses programmed into the system.

(3) Web server port
Displays the port number of the web server.

(4) Unit type
Displays either type of unit NX-100 or NX-100S.
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6.2. Menu

6.2.1. File

Save to file (Ctrl+S): Overwrites and saves the system setting file.

Reopen file (Ctrl+O): Rereads the saved system setting file.

Log file download: Saves the log of all NX-100 and NX-100S operations programmed into the system.

Exit: Exits the program.

6.2.2. Edit

Add
NX-100:Adds the selected NX-100 to the list (edit screen).
NX-100S:Adds the selected NX-100S to the list (edit screen).

Delete: Deletes the selected NX-100 or NX-100S from the list (edit screen).

Clear: Deletes all NX-100 and NX-100S units from the list (edit screen).

6.2.3. Setting

Upload (Ctrl+U): Writes the settings currently being edited into the NX-100 and NX-100S.

Download (Ctrl+D): Downloads the settings from the NX-100 and NX-100S, and displays them on the edit
screen. (Not saved.)

Firmware update: Updates the NX-100 and NX-100S firmware.

6.2.4. Help

Help: Displays help contents.

Version data: Verifies the version number of the NX-100 Setup program.
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6.2.5. Buttons

(1) Save button: Saves and overwrites the system setting file.

(2) NX-100 Add button: Adds NX-100 units to the network list (edit screen).

(3) NX-100S Add button: Adds NX-100S units to the network list (edit screen).

(4) Delete button: Deletes NX-100 and NX-100S units from the network list (edit screen).

(5) Upload button: Writes the currently edited settings into the NX-100 and NX-100S.

(6) Download button: Downloads NX-100 and NX-100S settings and displays them on the edit screen.
(Not saved.)

(1) (2) (3) (4) (5) (6)



3-16

Chapter 3:  SYSTEM SETTINGS (NX-100 SETUP PROGRAM)

6.3. Network Setting 

Step 1. Click on the [Network] tab of the System Setting Tool. 
The setting screen will be displayed. 

Step 2. Set each item. 

(1) IP address
Enter the unit's IP address. After the IP address is set with the Unit Scanning Tool, the assigned IP
address is indicated when the unit setting file is loaded into the PC.

(2) TCP port number assignment
Designate the web server port number and the base number of the other TCP port. The port number can
be set within the range of 1 – 65535.

[Web server]
Enter the web server port number. Its default is "80."



3-17

Chapter 3:  SYSTEM SETTINGS (NX-100 SETUP PROGRAM)

[Start port No.]
Enter the base number of the TCP port (other than web server, which is used by the unit). The default is
"5000." Enter the number from within the range of 1 – 65532. 

The TCP ports are assigned as follows:

Port

Web server

Broadcast control

PC control

Contact bridge

Serial bridge

Port No.

Web server

Start port No. + 0

Start port No. + 1

Start port No. + 2

Start port No. + 3

Protocol

TCP

TCP

TCP

TCP

TCP

Default

80

5000

5001

5002

5003

(3) UDP port number assignment
Designate the base port number to be used by UDP.

[Start port No.]
Enter the base UDP port number to be used by the unit. The default is "5000." Enter an even number from
within the range of 1 – 65526. 
The UDP ports are assigned as follows:

Port

Streaming

Error correction

Resend

Serial bridge

Fs* correction

Port No.

Start port No. + 0

Start port No. + 2

Start port No. + 4

Start port No. + 6

Start port No. + 7

Protocol

UDP

UDP

UDP

UDP

UDP

Default

5000

5002

5004

5006

5007

* Sampling frequency

Caution
Since UDP port No. 15000 is used by the unit, numbers between 14990 and 15000 cannot be used.
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6.4. Broadcast Spec Setting 

Step 1. Click on the Broadcast Spec tab of the System Setting Tool.
The setting screen will be displayed. 

Step 2. Select the usable bandwidth at Navigator.
Selection of the usable bandwidth automatically sets recommended values except those related to
Multicast. If no problems are foreseen, perform the setting as is, without changing this value.

Note
For bandwidth and multicast streaming, consult with on-site network management personnel.

Step 3. Set each item while referring to the bandwidth and delay time indicated in the Information area
located at the bottom of the screen. 

Caution
Broadcasts are interrupted when the set bandwidth is displayed in red in the Information area. (The
bandwidth is indicated in red whenever this setting exceeds the per-stream usable bandwidth.)

(1) Sampling frequency [kHz]
Select a sampling frequency for both transmission and reception from [8], [16], and [32] kHz. Sound
quality improves with higher sampling frequencies, however this makes the usable bandwidth wider.

Caution
Local broadcasts are disabled if a transmission sampling frequency of [32] kHz is selected (refer to
broadcasting direction in "the Broadcast Pattern Setting" on p. 3-20).
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(2) Packet size
Select the size of audio packet.
The packet size cannot be changed when [Resend] is selected in the Packet loss recovery item. Smaller
packet sizes result in a wider bandwidth, however delay times become shorter.

(3) Compression
Select [Yes] or [No]. Audio signal compression narrows the bandwidth. To narrow the bandwidth of the
network, it is highly recommended that compression be enabled.

(4) Packet loss recovery
Selects one of three recovery methods used when an audio packet is lost: [Standard], [Error Correction],
and [Resend]. Refer to p. 6-4 for details regarding each recovery method.

[If "Error Correction" is selected]
A scale for setting the correction level appears. Higher settings increase correction capability, however
delay times are also made longer. 

[If "Resend" is selected]
A scale for setting delay times appears. Longer delay times increase correction capability. 

(5) Enable multicast and Multicast address
Set whether or not to use multicast for broadcasts. Ticking the [Enable multicast] checkbox makes it
possible to enter the multicast address. The effective address range is from (225.0.0.0) to
(239.255.255.255).

Note
Be sure to consult with network management personnel before performing this setting.



3-20

Chapter 3:  SYSTEM SETTINGS (NX-100 SETUP PROGRAM)

6.5. Broadcast Pattern Setting

6.5.1. Setting new broadcast patterns

Step 1. Click on the [Broadcast Pattern] tab of the System Setting Tool.
The setting screen will be displayed.
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Step 2. Press the Add button.
The edit area becomes available for editing. Up to 20 patters can be set for each unit.

Step 3. Enter a broadcast pattern name.

Caution
Avoid assigning a name already programmed.

Step 4. Select the broadcasting direction from [Transmission], [Reception], and [Local].

Transmission: Transmits broadcast signals to the connected NX-100 and NX-100S units.
Reception: Receives broadcast signals from the connected NX-100 and NX-100S units.
Local: Makes broadcasts from the Audio Input of the NX-100 or NX-100S unit to its Audio

Output.

Selecting [Transmission] or [Reception] permits selection of the connected unit.

Caution
[Local] broadcasts cannot be made when the transmission sampling frequency is set to 32 kHz in the
Broadcast Spec setting.

Step 5. Select the connected unit from the displayed list (when [Transmission] or [Reception] is selected)

Cautions
• Only those units connected to the LAN can be selected.
• Only one location can be selected when the multicast function is not used. (Also one location for

reception.)
• Only units designated for multicast streaming can be group-selected.
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6.5.2. Editing broadcast patterns

Step 1. Click on the [Broadcast Pattern] tab of the System Setting Tool. 
The setting screen will be displayed.

Step 2. Click on the broadcast pattern to be edited.
The setting contents are displayed in the edit area, allowing editing.

Tip
To delete a previously programmed broadcast pattern, click on the broadcast pattern to be deleted,
then press the Delete button.

Step 3. Re-enter or reselect the section to be changed.
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6.6. Contact Setting

6.6.1. Contact input setting

Step 1. Click on the [Contact] tab of the System Setting Tool. 

Step 2. Click on the selection button for the contact input channel number.
The setting contents will be displayed.

Step 3. Tick the [Enable contact] checkbox.
The setting contents can be edited.
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Step 4. Set the type to [Momentary] or [Latch].

Momentary: The designated broadcast pattern or other unit's contact output is activated during the
interval that input is ON. Activation stops while the input is OFF.

Latch: The designated broadcast pattern or other unit's contact output is activated when the
input is turned ON, and the activation mode continues even if the input is turned OFF.
Activation stops when the input is turned ON again.
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Step 5. Set Polarity to [Make] or [Break].

Make: ON when the contact is closed. 
Break: ON when the contact is opened. 

Step 6. A list of the programmed broadcast patterns is displayed in the [Broadcast pattern] screen. Tick the
checkbox to select the pattern.

Cautions
• Broadcasts cannot be made if the set frequency band exceeds the usable bandwidth. 
• Up to 4 broadcast patterns can be selected for transmission, and 1 pattern for reception. (Only 1

pattern for multicast streaming.)
• When no broadcast pattern is displayed, no broadcast patterns are programmed. In such cases,

create new patterns on the Broadcast Pattern setting tab screen.

Step 7. Click to select the connected unit from the [Contact bridge unit] list.

Cautions
• Only those units connected to the LAN can be selected. 
• Up to 64 locations can be selected.
Note
For details regarding contact bridge operation, refer to p. 6-5.
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6.6.2. Contact output setting

Step 1. Click on the [Contact] tab of the System Setting Tool.

Step 2. Click on the selection button for contact output channel numbers.
The setting contents will be displayed.

Step 3. Tick the checkbox for [Enable contact].
The setting contents can be edited.

Step 4. Select Mode from [Standard], [STATUS Output], and [ERROR Output].

Standard: Provides output by way of control from a PC or contact inputs of other units or
original unit.

STATUS Output: Provides contact output synchronizing with the unit's STATUS indicator operation.

ERROR Output: Provides contact output synchronizing with the unit's ERROR indicator operation.

Note: To use the Contact bridge function, select [Standard].
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Step 5. Set the type to [Momentary] or [Latch].

Momentary: Provides output during the period between receiving an activation request and receiving
a stop request.

Latch: Provides 1 second of output upon receiving an activation request and 1 second of output
upon receiving a stop request.

Note
[Latch] cannot be selected when setting Mode to [STATUS Output] or [ERROR Output].
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Caution
The unit's correct operation cannot be ensured if both activation and stop signals
are received during the 1-second output interval. 

Step 6. Select Polarity from [Make] or [Break].

Make: ON when the contact is closed. 
Break: ON when the contact is opened. 

Step 7. Set OFF delay time from [0] – [60] seconds.
Adjust the displayed scale or enter an OFF delay time of 0 – 60 seconds for the duration between
receiving a termination request and actually turning OFF the contact. When in Resend mode (refer to
p. 3-19, Packet loss recovery) and making broadcasts with longer delay times, set the OFF delay time
to correspond to the delay time.

Note
For more information regarding OFF delay times, refer to p. 6-4. 
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6.7. Serial Bridge Setting 

Step 1. Click on the [Serial] tab of the System Setting Tool.

Step 2. Tick [Enable serial port].
The setting screen will be displayed, allowing entry of each item.

NX-100 only

Step 3. Set each item.

(1) Protocol
Select the serial bridge communication method.

TCP server: The unit selected on the setting screen functions as a TCP server and carries out
communications. 

TCP client: The unit selected on the setting screen functions as a TCP client and carries out
communications. Clicking the radio button permits selection of the connected unit. 

UDP: Carries out UDP communications. Clicking the radio button permits selection of the
connected unit.

(2) Target unit 
Select the unit to be connected.

Caution
Only units connected to the LAN can be selected. 
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(3) Baud rate
Select [9600], [19200], [38400], [57600] or [115200]

(4) Data length
Set to either [7 bits] or [8 bits].

(5) Parity
Select [Even], [Odd] or [None].

(6) Stop bits
Select [1 bit] or [2 bits].

(7) Flow control
Select the type of flow control.

None: Flow control is not performed.
Xon/Xoff: Performs software flow control.
Hardware: Performs hardware flow control. 

(8) Auto cutoff time (minutes)
Set the time interval (timeout duration: 0 – 60 minutes) before the connected unit is automatically
disconnected following the end of the last communication. The connected unit is not disconnected if the
timeout duration is set to [0]. This function is only available for TCP connections.

(9) Transmit/receive raw data
Tick the checkbox when transmitting and receiving raw data. Data with control information to be utilized
between NX-100 units is usually transmitted, but raw data communications are generally carried out
without such control information. However, when communications with other connected units are cut off,
this cannot be detected. Raw data communications are only possible while in TCP connection mode.

Note
Serial bridge function data can be transmitted at every 20 ms intervals or when its data length becomes 1024
bytes within 20 ms. This serial bridge function cannot be used for the equipment that communicate with data
less than 1024 bytes long at intervals shorter than 20 ms.
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6.8. System Settings

Step 1. Click on the [System] tab of the System Setting Tool. 
The setting screen will be displayed. 

Step 2. Perform settings for each item.

(1) Unit
Enter the unit name. 

(2) Audio input
Enter the name of the audio input unit connected to the unit.

(3) Audio output
Enter the name of the audio output unit connected to the unit.

(4) Firmware version
Indicates the unit's firmware version number.

6.9. Saving the Unit Setting Files

Save the unit setting file to the specified location.*

* Setup program's data folder. The save location cannot be manually designated.

Click on the Save button or select [File] → [Save].
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6.10. Reopening Unit Setting Files

Reopen the saved unit setting files.
The program automatically reads the saved unit setting files at the time of program activation. Whenever a file
has not yet been saved after edit completion, its contents can be reverted back to the previous settings.

Select [File] → [Reopen file].

6.11. Downloading the Operation Logs

Download all NX-100's and NX-100S' operation logs programmed into the system and save them to a
specified location*.

* Setup program's data folder. The save location cannot be manually designated.

Select [File] → [Log file download].

6.12. Uploading Unit Setting Files

Upload the currently opened setting file to the NX-100 and NX-100S.

Step 1. Click on the toolbar Save button or select [File] → [Save to file].
The setting file will be saved.

Step 2. Click on the Upload button or select [Setting] → [Upload].

Note
Setting file upload takes some time. Take care to never switch off the unit's power during the upload. (The
Status indicators on the NX-100's and NX-100S' front panels flash during the upload.)

6.13. Downloading Unit Setting Files

Read the currently-connected NX-100's and NX-100S' setting contents into the System Setting Tool. 

Click on the Download button or select [Setting] → [Download].
Programmed setting data of the units connected to the system will be displayed. 

6.14. Updating Firmware

Update the firmware of all NX-100 and NX-100S units programmed into the system.

Step 1. Select [Setting] → [Firmware update].

Step 2. Select firmware file.
Firmware will be written into all connected NX-100 and NX-100S units. 

Note
Take care to never turn off or reset the unit's power during firmware update. (The Status indicator on each
unit's front panel flashes during the update.)

[Update information]
• The latest versions of the following software and manuals are open to the public on the TOA's download site

http://www.toa-products.com/international/: NX-100 firmware, NX-100 software (Setup program and
Operation program), and Instruction manuals (Installation setup manual and Operations manual). 
Please download them from the above web site.

• The version of each instruction manual is in the lower right corner on the last page expressed in a year-
month format. Example: "200406" represents 2004, June.
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7. CHANGING THE SYSTEM NAME AND PASSWORD

Step 1. In the Installation Setting Program, click on [Password Change] on the initial screen.
In the Management Setting Program, select [Help] → [Version data], and a dialog will then be
displayed. Click on the Change password button.
The Password Change screen will be displayed.

Step 2. Enter a new system name and password.
Use up to 15 alphanumeric characters to enter the system name and password. (They can be set to
blank.)
Enter the password a second time for verification.
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1. OUTLINE OF SETTING USING BROWSER

Settings can also be changed without requiring installation of the dedicated NX-100 software by individually
connecting to each NX-100/100S using the browser*. 
For NX-100/100S units connected by way of the NAT function, such as an access via internet, perform
settings from the browser.

* Browsers that ensure correct NX-100/100S operation:
Internet Explorer 8, Internet Explorer 7, and Internet Explorer 6

Notes
• Settings cannot be performed if the network is not correctly set. In particular, new units shipped from the

factory may have duplicate default IP addresses or settings that assume the NX-100/100S is not connected
to the same network as the PC.

• Complete network settings before using the NX-100 Installation Setting program. If performing setup by the
browser, disconnect the unit from the network and connect it directly to the PC's LAN port using a cross
cable.

• Should the power be switched off during setting changes, the unit may be damaged.

• Changed settings are enabled after the NX-100/100S is restarted. Be sure to restart the unit whenever
settings are changed. Broadcasts are stopped during unit restart.

2. SETTINGS

Step 1. Start up the browser and enter the URL.

Note
The factory-preset IP address is "192.168.1.1" and web server port No. is "80." When the web server
port No. is "80," the description of the port number that follows the colon [:] can be omitted.

URL Example

http://<IP address>:<Web server port No.> /admin-e.htm http://192.168.1.1/admin-e.htm

The User Authentication dialog will be displayed. (Note that the dialog display may differ depending
on the browser used.)
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Step 2. Enter a user name and password, then press the OK button.

Notes
• For the User name, enter the system name preset as default or by change.
• Both the user name and password are case-sensitive.

The default system name is factory-preset to "NX-100" and the password to "guest." 
To change them, refer to p. 4-28.

The setting menu window will be displayed if the user name and password are correctly entered.

This figure represents the NX-100.

Step 3. Set each item.
Referring to the corresponding pages, perform each
setting. 
Note that serial bridge setting can be performed for the
NX-100 only.

Caution
When displaying each browser setting screen, the screen
is not correctly displayed if the Back or Forward button of
the browser is used. Use the menu on the left-hand side
of the window. 

Menu Item

Network setting (See p. 4-4)

Broadcast spec setting (See p. 4-6)

Broadcast pattern setting (See p. 4-9)

Contact setting (See p. 4-13)

Serial bridge setting (See p. 4-18)

Log management (See p. 4-20)

System management (See p. 4-27)

NX-100 only
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3. NETWORK SETTING

Set the NX-100/100S unit's network.

This figure represents the NX-100.

(1) IP Address
Enter the NX-100/100S unit's IP address. (Factory-preset to "192.168.1.1.")

(2) Subnet Mask
Set the mask address. (Factory-preset to "255.255.255.0.")

(3) Default Gateway
Enter the gateway address if the unit is being used outside its assigned subnet.
(Factory-preset to "0.0.0.0.")
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(4) Port No.
Set the start port number to be used by each protocol.
The assigned port numbers are indicated. 

[TCP Port No. Assignment]
• Web server

Enter the web server port number
(Range: 1 – 65535; Factory-preset: 80)

• Start port no.
Enter the first TCP port number other than the HTTP, which is used by the NX-100/100S.
(Range: 1 – 65532; Factory-preset: 5000)

[UDP Port No. Assignment]
Designate the first port number to be used by the UDP.

• Start port no.
Enter the first UDP number to be used by the unit.
(Range: EVEN numbers 1 – 65526; Factory-preset: 5000)

Caution
Since UDP port No. 15000 is used by the unit, numbers between 14990 and 15000 cannot be used.

(5) Save button
Updates the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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4. BROADCAST SPEC SETTING

Set the specifications that determine broadcast streaming quality. The NX-100/100S starts its broadcasts
based on this setting.

This figure represents the NX-100.

(1) Navigator
Select the usable bandwidth and type of line, and press the Set button. A recommended values will then
be set. If no problems are foreseen, perform the setting as is, without changing these values.

Note
Be sure to consult with network management personnel regarding bandwidth, type of line, and multicast
streaming.
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(2) Information
Indicates the delay time, bandwidth, and whether or not broadcasts are possible when broadcasts are
made using values selected in the Broadcast Spec settings.

[Delay]
The delay time is the duration until an audio signal received at the NX-100 and NX-100S passes through
the network and is broadcast by other connected NX-100 and NX-100S units. 

[Bandwidth]
Indicates the bandwidth for voice streaming over the network. The bandwidth used is indicated in red if the
setting exceeds the usable bandwidth set in the Navigator section.

[Broadcasts possible with this spec]
Broadcasts that are possible with the set Spec are marked with "OK", and those that are not possible are
marked with "NG." The conditions under which broadcasts can be made are as follows:

Transmission only (broadcasts from the original unit to other units):
Broadcast signals can be sent to a connected unit if the transmission bandwidth is within the set
bandwidth.

Reception only (broadcasts from other units to the original unit):
Broadcast signals can be received from a connected unit if the reception bandwidth is within the set
bandwidth.

Local broadcast (transmissions from the original unit's audio input to its audio output):
Local broadcasts cannot be made if the transmission sampling frequency is set to 32 kHz.

Multiple unicast streaming and Two-way:
Cannot be performed when packet transmission intervals are short. Adjust the sampling frequency,
compression, packet size, packet loss recovery and its level.

(3) Audio Setting

[Sampling Frequency]
Select the transmission and reception sampling frequencies from [8], [16], and [32] kHz. Sound quality
improves with higher sampling frequencies, however this makes the bandwidth wider.

[Compression]
Select [Yes] or [No]. To narrow the bandwidth of the network, it is highly recommended that compression
be enabled.
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(4) Network Relations

[Packet Size]
Select the size of audio packet. 
The packet size cannot be changed when [Resend] is selected in Packet Loss Recovery item. Smaller
packet sizes result in a wider bandwidth, however delay times become shorter. 

[Packet Loss Recovery]
Select one of three recovery methods used when an audio packet is lost: [Standard], [Error Correction],
and [Resend]. Refer to p. 6-4 for details of each recovery method. 

In case [Error correction] is selected, the correction level can be changed, allowing selection from [1
(Low)], [2], [3], and [4 (High)]. Higher settings increase correction capability, however delay times are also
made longer. 
In case [Resend] is selected, delay times can be entered for 5 – 30 seconds. Longer delay times increase
correction capability. Note that [Resend] cannot be selected if [Compression] is set to "No."

[Multicast]
The multicast address must be set when sending multicast streaming. Selecting "Yes" for Multicast allows
the multicast address to be entered. The effective address range is from (225.0.0.0) to (239.255.255.255).
Perform this setting while taking care that the same number is not duplicated among the units connected
to the same network.

Note
Be sure to consult with network management personnel before performing this setting. 

(5) Sampling Frequency Correction

Refer to p. 6-4 for sampling frequency correction.

[Transfer Setting between Networks]
Perform the setting to transfer sampling frequency correction data between different networks. (Correction
data within the LAN* are automatically transmitted and received.)

* Broadcast effective range

No: Corrects correction data only in the LAN, without transferring data to other networks.
Reception: Receives correction data from other networks. Enter the receiving source IP address in the

corresponding box that is ready for entry. When receiving correction data via Multicast, tick
the checkbox of "Receives via Multicast." and enter the Multicast IP address to be used.

Transmission: Transmits correction data to other networks. Since the data input boxes for the target
transmission unit become ready for entry, enter both the IP address and port number of the
target unit.

(6) Save button

Updates the NX-100/100S setting file. 

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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5. BROADCAST PATTERN SETTING

The broadcast pattern is determined by the combination of broadcast direction and the units targeted to
receive or transmit the broadcast, and is set in the unit that initiates the broadcast. The pattern then starts the
broadcast when a contact or program operation input is received. Local broadcasts which do not use the
network or single stream broadcasts can also be set as broadcast patterns. (Target receiving unit: 1; Target
unicast transmission unit: 1; Target multicast transmission units: 64)
Create a new broadcast pattern by clicking on the Pattern Addition button, or select and edit a pattern which
has already been programmed. 

This figure represents the NX-100.

Pattern Selection Area

Pattern Edit Area
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5.1. Pattern Selection Area

(1) Programmed Pattern List
Displays a list of the unit's programmed patterns, and whether or not broadcasts are possible. 
Patterns which cannot be broadcast due to the Broadcast Spec settings are highlighted in red with an
"NG" displayed in the corresponding "Enable Broadcast" column. Disabled broadcasts are usually caused
by incorrect multicast or transmission sampling frequency settings (for instance, local broadcasts cannot
be made at 32 kHz). Be sure to review the Broadcast Spec settings.

[Pattern Selection]
Select the pattern to edit or delete.
After selection, press the Pattern Edit button to edit, and the Pattern Deletion button to delete. 

(2) Pattern Edit button
Displays the selected broadcast pattern in the pattern edit area. 
The "Pattern Edit" title is displayed in the edit area.
Pressing the Save button after edit updates the pattern setting.

(3) Pattern Addition button
Adds a new broadcast pattern. The "Addition of Pattern" title is displayed in the pattern edit area. Pressing
the Save button after edit adds the pattern. The new pattern is added to the programmed pattern list and
displayed in the pattern selection area.

(4) Pattern Deletion button
Deletes the selected broadcast pattern and updates the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.

5.2. Pattern Edit Area

The pattern addition display differs from the pattern editing display for the selected pattern. (The "Addition of
Pattern" screen is displayed by default when no pattern is selected.)

5.2.1. Pattern addition

"Addition of Pattern" is displayed as the pattern edit area's title when no pattern is selected or when the
Pattern Addition button is pressed.

(1) Name
Enter the pattern name to be programmed into the NX-100/100S.
"New Pattern" is displayed when the Pattern Addition button is pressed. Change this indication to the
appropriate pattern name.

Caution
Take care not to assign a pattern name which is already programmed.

(2) Direction
Select the broadcast direction.

Transmission: Broadcasts from the original unit to other units.
Reception: Broadcasts from other units to the original unit.
Local: Broadcasts from the original unit's audio input to its own audio output.

Caution
"Local" cannot be selected when the transmission sampling frequency is set to [32 kHz] in the Broadcast
Spec setting.
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(3) Target Unit
The IP addresses of the target NX-100 and NX-100S units are displayed.
When "Transmission" is selected in the Direction setting, broadcasts are sent all added NX-100 and
NX-100S target units. 
When "Reception" is selected, broadcasts are received from the added target NX-100 or NX-100S unit.
Target units cannot be added when "Local" has been selected.

[Target Unit Addition]
The combination of the broadcast direction and target unit that enables single stream broadcasts can be
set as the broadcast pattern. The number of target units that can be added is 1 unit for reception, and 64
units for transmission when multicast streaming is possible or 1 unit for transmission when multicast
streaming is not possible. 
Enter the IP address and transmission control port for each target unit, then press the Target Unit Addition
button. The set target unit will be added to the Target Unit list. 

(Example of addition to the Target Unit list)

Caution
Units are not added by merely entering them in the Target Unit Addition frame. Be sure to confirm that the
unit is added to the list after the Target Unit Addition button is pressed, and then press the Save button.
The Target Unit Addition button is automatically disabled when target units can no longer be added.

[Target Unit Deletion button]
Pressing the Target Unit Deletion button after selecting a target unit in the Target Unit List will delete the
selected unit from the list. Multiple target units can also be selected for deletion. 

(4) Audio Stream Target Port
Enter the port number of the target unit to be used by the audio stream.

(5) Save button
Updates the NX-100/100S setting file.
When adding a pattern, the unit's name appears in the Programmed Pattern List.

Note
The broadcast control port number and audio stream target port are displayed in the "Network Setting"
screen for the target unit. (Refer to p. 4-4, NETWORK SETTING.)

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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5.2.2. Pattern editing

When the Pattern Edit button is pressed while a programmed broadcast pattern is selected in the pattern
selection area, the Edit of Pattern title and the name of the pattern before being changed are displayed. The
setting contents of the pattern are also displayed in the pattern edit area for editing.

This figure represents the NX-100.

Press the Save button to program the edited pattern. Pressing the Save button will update the NX-100/100S
setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front panel of
the NX-100/100S is flashing.
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6. CONTACT SETTING

When the NX-100/100S unit's contact input is activated, its set broadcast pattern starts broadcasting while
simultaneously enabling other unit's contact outputs. Here, contact input and output settings are performed.

This figure represents the NX-100.

(1) Contact Selection
Select the contact to be set. Selecting the input or output channel number of the contact displays its
contact's setting contents.

(2) Enable/Disable Selection
Select "Enable" or "Disable" for the contact.
Select "Enable" when using the contact function. All setting items are then ready for entry.
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6.1. Contact Input Setting

Set the broadcast pattern to be started, and the contact bridge. When the contact input is selected, the screen
will switch over to the contact input setting screen. Select [Enable] and set the contact input contents.

(1) Operation Mode
Select from [Momentary] and [Latch]. Operations are as follows:

Momentary: The designated broadcast pattern or other unit's contact is activated while the input is ON.
The start mode stops when the input is OFF.

Latch: When the input is turned on, the designated broadcast pattern or other unit's contact is
activated, and the start mode continues even if the input is turned OFF. The start mode stops
when the input is turned ON again. 
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(2) Polarity
Set to either [Make] or [Break].
Make: ON when contact is closed. 
Break: ON when contact is opened.
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(3) Broadcast Pattern
The NX-100/100S unit's list of programmed broadcast patterns is displayed. Select the pattern to be
started.
Patterns which cannot be broadcast due to the Broadcast Spec settings are highlighted in red with a "NO"
displayed in the corresponding "Enable" column. Disabled broadcasts are usually caused by incorrect
multicast or transmission sampling frequency settings (for instance, local broadcasts cannot be made at
32 kHz).

[Select]
Select the pattern to be started. When cancelling the selection, click on the same checkbox again to
remove the tick.

[Pattern name]
Displays the programmed broadcast pattern name.

[Direction]
Displays the type of broadcasting.
Transmission (Multicast): Transmits a single stream broadcast to multiple units. Multicast must be set to

"Yes" in the Broadcast Spec Setting.
Transmission (Unicast): Transmits a single stream broadcast to a single unit.
Reception: Receives broadcasts from the target unit.
Local: Broadcast from the original unit's input to its own output. 

[Enable]
Indicates whether or not the programmed broadcast pattern can be broadcast. If "NO" is displayed for a
pattern, review the Broadcast Spec settings.

[Bandwidth]
Indicates the total bandwidth used by the set pattern. 

Caution
Broadcasts cannot be made if the setting exceeds the available bandwidth.

(4) Contact Bridge
The Contact Bridge refers to the function that enables the contact outputs of other connected unit or
original unit when the original unit's contact input is activated. Here, select NX-100/100S contact outputs
to be activated when the original unit's contact input is activated.
Note
For details regarding contact bridge operation, refer to p. 6-5.

[Programmed Target Output]
Tick on the appropriate boxes when wishing to change only the programmed target unit's contact output
channel. Tick the corresponding rightmost checkbox to select programmed target units to be deleted, then
click on the Delete button to remove from the list.

[New Connect Point]
When performing initial programming, enter the new target unit's IP address, contact control port number
and select the channel number, then click on the Add button.
Entering the original unit's IP address and port number as a new connecting point permits the original
unit's contact output to be activated.

(5) Save button
Updates the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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6.2. Contact Output Setting

Set the contact output to be activated when the NX-100/100S is enabled by other unit or the operation
program. Selecting a contact output will switch the display to the contact output setting screen. Select
"Enable" and set the contact output contents. 

This figure represents the NX-100.

(1) Mode
Select Mode from [Standard], [STATUS Output], and [ERROR Output].

Standard: Provides output by way of control from a PC or contact inputs of other units or original
unit.

STATUS Output: Provides contact output synchronizing with the unit's STATUS indicator operation.
ERROR Output: Provides contact output synchronizing with the unit's ERROR indicator operation.

Note
To use the Contact bridge function, select [Standard].
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(2) Type
Select from [Momentary] and [Latch].

Momentary: Provides output during the period between receiving an activation request and receiving a
stop request. 

Latch: Provides 1 second of output upon receiving an activation request and 1 second of output
upon receiving a stop request. 

Note
[Latch] cannot be selected when setting Mode to [STATUS Output] or [ERROR Output].

1 s

1 s

Broadcast and 
activation data

Contact output

Contact output

Make

Break

• Latch

Broadcast and 
activation data

Contact output

Contact output

Make

Break

• Momentary

ON

ON

ON

ON

ON

ON

ON

ON

ON

ON

Activation Stop

Activation Stop

Caution
The unit's correct operation cannot be ensured if both activation and stop signals
are received during the 1-second output interval. 

(3) Polarity
Select Polarity from [Make] and [Break].
Make: ON when the contact is closed. 
Break: ON when the contact is opened. 

(4) Contact OFF Delay Time [sec]
Enter an OFF delay time of 0 – 60 seconds for the duration between receiving a termination request and
actually turning OFF the contact. When in Resend mode and making broadcasts with longer delay times,
set the OFF delay time to correspond to the delay time.

Note
For more information regarding OFF delay time, refer to p.6-4. 

(5) Save button
Updates the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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7. SERIAL BRIDGE SETTING  NX-100 only

Perform serial bridge settings.

(1) Enable/Disable Selection
Select "Enable" when using this function. All items can be ready for entry. 

(2) Network Setting

[Protocol]
Select the serial bridge communication configuration.

TCP Server: The original unit carries out communications as a TCP server. The NX-100 unit connected to
this server must be set as a TCP client in its protocol settings.

TCP Client: The original unit carries out communications as a TCP client. The target NX-100 unit must
be set as a TCP server in its protocol settings.

UDP: Carries out communications using UDP. The target NX-100 unit's protocol settings must be
set to UDP.

[Target Unit's IP Address]
Enter the target unit's IP address and port number.

Note
Enter the global IP address if using the Internet.
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(3) Serial Port Setting

[Baud Rate]
Select [9600], [19200], [38400], [57600], or [115200]

[Data Length (bit)]
Select to [7 bits] or [8 bits].

[Parity]
Select [Even], [Odd], or [None].

[Stop Bit]
Select [1 bit] or [2 bits]. 

[Flow Control]
Select the type of flow control. 
None: Flow control is not performed. 
Xon/Xoff: Performs software flow control. 
Hardware: Performs hardware flow control. 

(4) Other

[Automatic Cutoff Time (minutes)]
Set the time interval (timeout duration: 0 – 60 minutes) before the connected unit is automatically
disconnected following the end of the last communication. The connected unit is not disconnected if the
timeout duration is set to [0]. This function is only available for TCP connections.

[Transmit/Receive RAW data.]
Tick the checkbox when transmitting and receiving raw data. Data with control information to be utilized
between NX-100 units is usually transmitted, but raw data communications are generally carried out
without such control information. However, when communications with other connected units are cut off,
this cannot be detected. Raw data communications are only possible while in TCP connection mode.

(5) Save button
Updates the NX-100 setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100 is flashing.

Note
Serial bridge function data can be transmitted at every 20 ms intervals or when its data length becomes 1024
bytes within 20 ms. This serial bridge function cannot be used for the equipment that communicate with data
less than 1024 bytes long at intervals shorter than 20 ms.
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8. LOG MANAGEMENT

The unit's operation logs are displayed and saved.

This figure represents the NX-100.

(1) Operation Log button
Displays the NX-100/100S unit's operation log.

(2) Stream Log button
Displays streaming reception log.

(3) Log Save button
Saves log as a file in the PC.

(4) Operation Status button
Displays the NX-100/100S unit's current operation status. 
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8.1. Operation Log

The operation log screen is displayed when the Operation Log button is pressed on the Log Management
Menu screen.

This figure represents the NX-100.

[Operation button]

(1) Latest button
Updates the operation log to current data. 

(2) Prev. Page button
Moves to the previous page.

(3) Next Page button
Moves to the next page.

(4) Clear button
Deletes all operation logs.

(5) Display Change button
Displays or hides the web access log.
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[Items in the Table]

(1) Time
Indicates the time the event took place.

(2) Category
Indicates the type of log.
SESSION: Communications between units
REMOTE: Control by a PC
SWITCH: Monitoring of the contact input and the contact control 
SERIAL: Serial bridge operating status
SYSTEM: System information
WEB: Web server access log
STREAM: Status of audio stream

(3) Requesting Source
Indicates the IP addresses of communication parties or requesting sources of the events such as
designating contact channels.

(4) Contents
Indicates the contents of events. Levels are "Normal" (green), "Caution" (yellow), and "Error" (red).
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8.2. Saving Operation Logs

Follow the procedures below to save logs to a PC:

Step 1. Press the Operation Log Save button on the Log Management Menu screen.

A dialog is displayed.

Step 2. Press the Save Button.

The screen for selecting the storage location is displayed. 

Step 3. Select the storage location and enter a filename. 

Tip
The default filename is "[IP address].log."

Step 4. Select [All files] for "Save as type", then press the Save button. 
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8.3. Stream Logs

The Stream Log screen is displayed when the Stream Log button is pressed on the Log Management Menu
screen.

This figure represents the NX-100.

[Operation Button]

(1) Refresh button
Updates to the most recent data.

(2) Clear button
Deletes all stream reception logs.
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[Items in the Table]

(1) Current Stream
• Stream Data

• Reception Log
Correct Reception: The number of packets received correctly. (The number of error packets or

recovered packets is not included.)
Error: The number of packets whose packet length and header data are not

matched.
Restoration: The number of packets recovered by error correction or resending, out of

those that were lost due to network failures.
Loss: The number of packets not recovered, out of those lost due to network

failures. 
Silent tone insertion: The number of packets that caused no sound from the audio output.

(2) Past Reception Log
The network is possibly congested when the "Loss" number increases.
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8.4. Operation Status

The Operation Status screen is displayed when the Operation Status button is pressed on the Log
Management Menu screen.

This figure represents the NX-100.

[Operation Button]

(1) Refresh button
Updates status to the most recent data.

[Item in the Table]

(1) Broadcast
Indicates the condition of the current broadcast.

(2) Contact
Indicates the conditions (ON/OFF) of the contact input and output.
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9. SYSTEM MANAGEMENT

Note
The System Management Utility area is not displayed when in Management Setting mode.

[Unit Data]

(1) Unit Name
Enter the NX-100/100S unit's name.

(2) Audio Input Unit Name
Enter a name when connecting the audio input unit.

(3) Audio Output Unit Name
Enter a name when connecting the audio output unit.

This figure represents the NX-100.
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(4) Unit Data Change button
Updates only system setting data in the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.

[User Data]

System names and passwords can be changed.

Step 1. Enter the new system name in the System Name frame.

Tips
• The current system name is displayed.
• Use up to 15 alphanumeric characters to enter the system name. (It can be set to blank.)

Step 2. Enter a new password in the New Password frame.

Tip
Use up to 15 alphanumeric characters to enter the password. (It can be set to blank.)

Step 3. To confirm, enter the password entered in Step 2 in the New Password (verification) frame.

Enter the same password again for verification.

Step 4. Press the User Data Change button. 

Updates only user data in the NX-100/100S setting file.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front
panel of the NX-100/100S is flashing.
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[System Management Utility] 

(1) Setting File Upload
Uploads backed up setting files.

Step 1. Press the Browse button.

The Choose file dialog opens. 

Step 2. Select the backup file (.cfg extension), then press the Upload button. 

Update of the setting file begins.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the
front panel of the NX-100/100S is flashing.
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(2) Setting File Download
Backs up the setting file. 

Step 1. Press the Download button.

A dialog is displayed. 

Step 2. Press the Save button. 

A dialog is displayed.

Step 3. Select the save destination and enter a filename. 

Tip
The default filename "[IP address].cfg" is first displayed.

Step 4. Select [All files] for "Save as type", then press the Save button. 
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(3) Delete All Settings
Deletes all settings to return them to their original settings when supplied. 
The unit is factory-preset as follows:

IP Address: 192.168.1.1
Unit Name: NX-100S
System Name: NX-100
Password: guest

Other settings can be viewed with a browser or the setup program.

(4) Firmware Update
Updates firmware.

Step 1. Press the Browse button.

The Choose file dialog opens.

Step 2. Select the NX-100 firmware (".bin" extension), then press the Firmware Update button.

Caution
Never restart the unit or turn off the power during updates, or while the STATUS indicator on the
front panel of the NX-100/100S is flashing.

Tips
• The latest versions of the following software and manuals are open to the public on the Toa's

download site http://www.toa-products.com/international/: NX-100 firmware, NX-100 software
(Setup program and Operation program), and Instruction manuals (Installation setup manual
and Operations manual). Please download them from the above web site.

• The version of each instruction manual is in the lower right corner on the last page expressed in
a year-month format. Example: "200406" represents 2004, June.

(5) Restart button
Restarts the NX-100/100S unit. Be sure to restart any time the setting contents are changed. The change
is only enabled after restart.

Cautions
• Never restart the unit or turn off the power during updates, or while the STATUS indicator on the front

panel of the NX-100/100S is flashing.
• Broadcasts are interrupted when the unit is restarted.
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1. NX-100 OPERATION PROGRAM SUMMARY 

This operation program is used to set the control buttons used for broadcasts, and activate set NX-100 and
NX-100S broadcast patterns*1 or operate the contact output*2.

*1 The broadcast pattern is determined by the combination of the contents of the sound source and the units
targeted to receive the broadcast. One target unit can be set for unicast streaming, and up to 64 units for
multicast streaming. Only one pattern can be set per button.

Note
For more information concerning broadcast pattern settings, refer to Chapters 3 and 4.

*2 The NX-100's and NX-100S' contact output is controlled via the network. Up to 64 units x 8 channels can
be controlled per button.

2. STARTUP AND INITIAL SCREEN

Either double-click on the Operation program icon created on the desktop at the time of program installation or
double-click on the application [nx100_control.jar] installed in the software folder. The following initial window
(with nothing set in it) will then be displayed. 

Group buttons Selection buttons

The 10 Group buttons and 50 Selection buttons are displayed, with each button being numbered before any
button setting is performed. 
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3. OPERATION SCREEN DESCRIPTION

This section explains the screen layout, using the accompanying operation setting screen as an example.

(2)

(5)

(1)

(3) (4)

(1) Selection Button
Selects the broadcast pattern and contact output to be activated. The number of buttons programmed is
50 by default. One broadcast pattern or up to 64 units X 8 contact output channels can be set per
Selection button.

(2) Group Button
Used to simultaneously select two or more Selection buttons. The number of buttons programmed is 10 by
default.

(3) Start Button
Starts up the activation contents (broadcast pattern and contact output) selected with the Selection or
Group buttons.
This button can be hidden from display depending on the setting.

(4) End Button
Terminates activated broadcasts or contact outputs.

(5) Message Display Area
Displays responses to operations or the contents of errors.
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4. MENU

4.1. File

Exit: Terminates the software program currently in use.

4.2. Settings

Button setting: Set the Selection button and the Group button. 
Unit settings: If there is a unit that has not yet been programmed into the system using the NX-100 setup

program, select this menu item to add it as the operable unit.

4.3. Help

Help: Displays help contents.
Version data: Indicates the version number of the software program in use.



Before performing the setting using the Operation program

Set the NX-100 and NX-100S units in the system using the NX-100 Setup program.
Broadcast settings that will be activated by the operation program must all be programmed into each
connected unit as the "broadcast pattern."
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5. SETTING PROCEDURES USING THE OPERATION PROGRAM

(1) Add the unit to the system.

NX-100 and NX-100S units set with the Setup program as system units are automatically
recognized as operable units by the NX-100 Operation program. NX-100 and NX-100S
units which were set without using the NX-100 Setup program, such as the units
connected through the Internet, can be added to the system setting using the NX-100
Operation program.

(3) Set the Selection buttons.

Set the Selection buttons that select the broadcast patterns or contact outputs to be activated. 
Use the broadcast patterns which were programmed into the operable units (those units set with the
NX-100 Setup program and added in Step (1) above). 
Only one pattern can be programmed into each Selection button.
When simultaneously activating two or more broadcast patterns with the Group button, all of the
broadcast patterns to be activated must first be programmed into the Selection buttons. 

(4) Set the Group buttons. 

Use the Group button when wishing to simultaneously activate two or more broadcast patterns. Select
and assign the desired Selection buttons to each Group button.

If the system contains NX-100 and NX-100S
units not set with the Setup program such as
the units connected through the Internet.

If only NX-100 and NX-100S units
set with program are used.

If simultaneously activating multiple
broadcast patterns

The NX-100 Setup program cannot be used to set NX-100 and NX-100S units connected
via the Internet.

(2) Set the Button layout. 

Edit the Button layout.
Edit the layout of the Selection and Group buttons on the operation screen.
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6. UNIT SETTING ADDITION

Set the broadcast pattern data necessary for the Selection button setting using the NX-100 Setup program
(refer to Chapter 3). If a unit setting file has already been created, the data is automatically loaded. However,
NX-100 and NX-100S units which are connected through the Internet and cannot be set with the NX-100
Setup program must be added using the Operation program. In order to activate the NX-100 and NX-100S
broadcast patterns set using a browser (refer to Chapter 4), add the unit setting using the following procedure:

Step 1. Turn on the power to the NX-100 and NX-100S units for which the unit setting is to be added to make
connections possible.

Step 2. Start up the Operation program and select Setting → Unit settings. 

The User Authentication screen is then displayed. 

Step 3. Enter the system name and the password (the same password used in the setup program), then
press the OK button.

Notes
• Both the system name and the password are case-sensitive.

• The default system name is preset to "NX-100" and the password to "guest" when the unit is
shipped from the factory. To change, refer to p. 3-31 or p. 4-28.

The Unit Settings window is displayed if the system name and the password are correctly entered.

Note
In the initial startup mode, nothing is displayed in the Name, IP Address, Web, TCP and UDP
columns.
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Step 4. Press the Add button. 

A Unit Addition dialog is displayed. 

Step 5. Enter the IP address and port number (Web server, TCP start port number, and UDP start port
number), then press the OK button.

The entered data is displayed on the Unit Settings window.

Step 6. To save the changed contents without quitting the Unit Settings screen, press the Apply button. 

The NX-100 and NX-100S units with the entered IP addresses are connected, and their setting data
downloaded. 

The names are displayed on the Unit Settings screen when downloaded. The names cannot be
edited. 

The downloaded setting contents are saved to the software program's data folder.

Step 7. Press the OK button after all necessary NX-100 and NX-100S units have been added. 

The NX-100 and NX-100S units with the entered IP addresses are connected, and their setting data
downloaded. 

After the downloading of all units is completed, the Unit Settings screen is closed. 

The downloaded setting contents are saved to the software program's data folder.

Tips
• When a unit cannot be connected, the dialog [Connection failure to "XX". Delete?] is displayed. 

Pressing the OK button deletes the faulty NX-100 or NX-100S from the Unit Settings screen list,
and the data is saved.
Pressing the Cancel button cancels the setting change. Setting can be attempted again after
confirming the setting contents. 

• To delete an NX-100 or NX-100S unit from the Unit Settings screen list, select the desired unit and
press the Delete button.
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7. EDITTING THE BUTTON LAYOUT

The Start button can be set to enable or disable, and the layout of the Selection and Group buttons can be
edited.  

Step 1. Start the Operation program and select [Setting] → [Button setting].

The User Authentication screen is displayed.

Step 2. Enter the system name and the password (the same system name and password entered in the setup
program), then press the OK button. 

Notes
• Both the system name and the password are case-sensitive.

• The default system name is preset to "NX-100" and the password to "guest" when the unit is
shipped from the factory. To change, refer to p. 3-31 or p. 4-28.

The Button Setting screen is displayed if the system name and the password have been correctly
entered.
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Step 3. Click on the Button layout tab, then perform settings for each item shown on the screen.

In the initial startup mode, the following screen is displayed.

(1)

(2)

(3)

(1) Enable start button
When the box is unchecked, the Start button on the operation screen is disabled and hidden. In this case,
pressing the Selection or Group button automatically starts connection to the NX-100 or NX-100S
programmed for that button.

[Number of buttons]

Set the number of buttons on the operation screen.
There is no limit to the number of buttons that can be set.

(2) Single selection button: horizontal, vertical
Set the number of Single Selection buttons.
The number is preset to 5 horizontal by 10 vertical buttons (total 50 buttons).

(3) Group button: horizontal, vertical
Set the number of Group buttons.
The number is preset to 1 horizontal by 10 vertical buttons (total 10 buttons).

Step 4. Press the OK button after completing all editing tasks. 

The setting contents are saved in the software program's data folder, and the Button Setting screen is
closed.
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(1) (2) (3)

[Registration Contents List]

(1) Visible
Displays or hides the Selection buttons.

(2) No.
Selection button numbers. These numbers cannot
be changed. 
The buttons are arranged in the order of the
button number (see figure at right) on the 
operation screen.

(3) Indication Name
The name of the Selection button to be displayed
on the operation screen.

Selection button layout
(Example when 5 horizontal 
by 10 vertical buttons are set.)

8. SETTING THE SELECTION BUTTON CONTENTS

Program the broadcast pattern and the contact output activation setting into the Selection button. 

Step 1. Click on the Single selection button tab on the Button Setting screen (p. 5-8).

The Single selection button setting screen is displayed.

(Setting screen example)
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Step 2. Click off the checkbox ticks in the Registration Contents List for Selection buttons not to be used on
the operation screen. 

Buttons not marked with a tick are not displayed on the operation screen. 

Step 3. Click on the Selection buttons (the No. or Indication Name area) to be edited in the Registration
Contents List. 

The contents are displayed in the Edit area.

Step 4. Enter the Indication name in the Edit area.

Tip
There is no limit to the number of characters that can be entered, however the maximum number of
characters that can be displayed on the operation screen buttons for the screen size at startup is 16.
Because the number of displayed characters increases as the display screen increases in size, set
the number of characters to correspond to the screen size to be used.

Step 5. Check the broadcast pattern to be activated in the Broadcast pattern list.

Tips
• The Broadcast pattern list displays all patterns that have been programmed into all NX-100 and NX-

100S units in the system, including the NX-100 and NX-100S units added in the unit setting
procedure (p. 5-6).

• Only one broadcast pattern at a time can be selected.

• To clear the setting contents of the selected NX-100 or NX-100S broadcast pattern, press the
leftmost Clear button in the Edit area.

Step 6. Check the contact output to be activated in the Contact output list. 

The contact channel number to be output can be selected. 

(Setting screen example) Broadcast pattern list

Contact output list
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Step 7. Check the contact channel number to be used. 

Tip
To clear the setting contents of all NX-100 and NX-100S contact outputs, press the leftmost Clear
button in the Edit area.

Step 8. Press the OK button after completing all editing tasks. 

The setting contents are saved in the software program's data folder, and the Button Setting screen is
closed.
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9. SETTING THE GROUP BUTTON CONTENTS

The Group button is used to simultaneously select two or more Selection buttons. Program the desired
Selection buttons into the Group button.

Step 1. Click on the Group button tab on the Button Setting screen (p. 5-8).

The following initial Group button setting screen is displayed. 

(1) (2) (3)

[Registration Contents List]

(1) Enable
Displays or hides the Group buttons.

(2) No.
Group button numbers. These numbers cannot be
changed. 
The buttons are arranged in the order of the
button number (see figure at right) on the 
operation screen.

(3) Indication Name
The name of the Group button to be displayed on
the operation screen.

Group button layout 
(Example when 1 horizontal by
10 vertical buttons are set.)

Step 2. Click off the checkbox ticks in the Registration Contents List for Group buttons not to be used on the
operation screen. 

Buttons not marked with a tick are not displayed on the operation screen. 
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Step 3. Click on the Group buttons (the No. or Indication Name area) to be edited in the Registration Contents
List. 

The contents are displayed in the Edit area.

Step 4. Enter the Indication name in the Edit area.

Tip
There is no limit to the number of characters that can be entered, however the maximum number of
characters that can be displayed on the operation screen buttons for the screen size at startup is 16.
Because the number of displayed characters increases as the display screen increases in size, set
the number of characters to correspond to the screen size to be used.

Step 5. Check the Selection buttons to be assigned in the Registration button list.

Tips
• The Registration button list displays the numbers and names of the Selection buttons. Only the

Selection buttons programmed on the Single selection button setting screen can be checked. 

• If an invalid combination is set for broadcast, an error message will be displayed when the Start
button is pressed on the operation screen.

• To clear the setting contents of the selected Group button, press the Clear button.

Step 6. Press the OK button after completing all editing tasks. 

The setting contents are saved in the software program's data folder, and the Button Setting screen is
closed.

(Setting screen example)

Registration button list
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Points to Check

The NX-100 or NX-100S unit may have
failed. Check to see if the power supply
is correctly connected, that there are no
irregularities in the network, and whether
or not the NX-100's or NX-100S' front
panel-mounted Error indicator is lit.

Settings may be incorrect. Check both
the Setup and Operation programs for
correct setting.

The unit may be simultaneously
activated from multiple units. Restart up
the unit after broadcasts from other units
have finished.

10. ERROR MESSAGES

If any of the following messages is displayed in the message display area, the NX-100/100S may be
malfunctioning or have failed.

Note
In the above messages, "OO" indicates a unit's name and IP address, and "XX" indicates the channel
number.

Message

• "OO" connection failure.
• Connection failure to all designated units.
• "OO" connection failure - Incomplete broadcast.
• No broadcast. - Connection failure to all units.
• Interrupted broadcast to "OO".
• Interrupted broadcast from "OO".

Note: The above messages are displayed in red.

• "OO" connection failure. - Invalid system name.
• No start. - Invalid broadcast setting contents.
• "OO" contact output "XX" set to OFF.

• "OO" connection failure. - Maximum number of connectable
PCs exceeded.

• No start. - Designated unit busy.
• "OO" contact output "XX" already ON.
• "OO" contact output "XX" turned OFF by other contact or PC.
• "OO" contact output "XX" already OFF.
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1. EXPLANATION

1.1. IP Network and Address

The IP networks the NX-100 and NX-100S can use include Local Area Networks (LAN) used in small-scale
areas, such as within or on the premises of a company, and the Internet, which covers a wide area over
remote distances.

Internet RouterRouter

NX-100/100S
(C)

NX-100/100S
(A)

NX-100/100S
(B)

LAN

LANs differ from the Internet in the IP address to be used.

Local IP address (private IP address): This address is used and can be freely set within the LAN. 

Global IP address: This is the only address that is used to access the Internet. 
To use the NX-100 and NX-100S units through the Internet, fixed
global IP addresses must be acquired and assigned to them or the
router if it is used.

When a connection is made from Unit B to Unit A in the figure, the local address can be used. However, when
a connection is made from Unit C to Unit A, the global IP address must be used. 

The fixed global IP address must be assigned to the units connected via the Internet. 
When selecting an NX-100 or NX-100S which is connected through the Internet as the "target connection unit"
for a broadcast pattern, contact or serial bridge* in NX-100 or NX-100S unit setting, the fixed global IP
address must be designated. 
Consult with network management personnel or the ISP (Internet service provider) concerning the acquisition
of a fixed global IP address. 

* The serial bridge function is valid only for the NX-100.
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1.2. Network Address Translation (NAT) and Setup Software Programs

Because the Internet cannot be accessed using the local IP address, the local IP address must be converted
into the global IP address by means of Network Address Translation (NAT).

Internet Router 2Router 1

NX-100/100S
(C)

NX-100/100S
(A)

NX-100/100S
(B)

LAN

Connections can be made from Unit C to Unit A using the global IP address. The global IP address used for
the connection is converted into the local address for Unit A by Router 1.

Note that the NX-100 Setup program is not designed to enable the NAT function. Use a browser to select
units connected by way of the NAT as the target connection unit for the broadcast pattern, contact or serial
bridge* in the NX-100 and NX-100S unit settings. 

* The serial bridge function is valid only for the NX-100.

1.3. IP Broadcast and Unit Scan

The IP broadcast communication method is used to scan the units connected to the network. Units can only
be scanned within the effective range of the IP broadcast. 
The address to be used is 255.255.255.255.  

NET1

NET2

Router

Router NX-100/100S
(C)

NX-100/100S
(A)

NX-100/100S
(B)

PC

IP broadcast does not reach beyond the router covering range even in the LAN.
In the above figure, NET1 represents the LAN and NET2 represents the effective range for IP broadcast. For
example, if the PC is used to scan the units in the figure, Unit C cannot be scanned even though it is located
within the same LAN.

Note
Follow the instructions of the network management personnel for the effective range of the IP broadcast.
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1.4. Multicast and Simultaneous Multiple Broadcasts

The multicast communication method can be utilized to make simultaneous broadcasts to two or more units.
The advantage of multicast operation is the possibility of decreasing traffic. Networks that use multicast
communication need to be supported by multicast addresses and Internet Group Management Protocol
(IGMP). The effective multicast address range is from 225.0.0.0 to 239.255.255.255.

Note
Follow the instructions of the network management personnel for the effective range of the broadcast.

1.5. Packet Loss Recovery

The NX-100 and NX-100S convert audio data into IP packets to carry out communications. According to the
condition of the network to be used, packets may be lost, deteriorating sound quality. The NX-100 and NX-
100S offer the following 3 different selection modes for recovering such lost packets.

Standard: Corrects for lost packets with a silent gap. This method helps reduce delay times and
bandwidth, and is appropriate for applications that emphasize real-time operability. However,
it is not well-suited to networks in which many packet losses may occur, because the good
sound quality cannot be maintained.

Error Correction: Recovers lost packets with redundant data. Since only short-time losses can be corrected,
this method is not appropriate for networks in which many packet losses may occur. It is,
however, appropriate for applications that require high sound quality, such as LAN, which
have lower chances of packet loss. 

Resend: Corrects by automatically resending lost packets. All packet losses that occur within the
preset delay time can be corrected. High sound quality can be maintained even on such
networks as the Internet, which may generate many packet losses. This method, however, is
not well-suited to applications that emphasize real-time operability, because of longer delay
times. 

Standard

Note: Numbers represent level of advantage in the order of 1, 2, 3.

Error correction

Resend

Packet loss recovery ability Real-time operability Band occupation

3 1 Small

2 2 Moderate

1 3 Large

1.6. Contact OFF Delay Time

Depending on the packet loss recovery setting, delay times may be generated in broadcasts.
Long delay times do not take place in the contact bridge function. Therefore, if the contact is set so that it
becomes OFF when broadcasts are terminated, the contact may be turned OFF before broadcast completion. 
To leave the contact ON until broadcast completion, the contact OFF delay time of the NX-100 or NX-100S
that provides contact output needs to be set to be longer than the broadcast delay time in the contact setting.
(The broadcast delay time is displayed on the Broadcast Spec setting screen.)

1.7. Sampling Frequency Correction

Synchronizes all NX-100 and NX-100S operation clocks in the system. 
Unless the operation clocks are all synchronized, sound losses can occur in broadcasts that last more than 2
minutes. For example, to realize sampling frequency (fs) correction between units connected to Networks A
and B, perform fs correction data transmission setting for any one of the NX-100 and NX-100S units
connected to Network A. Set the target transmission unit of the correction data to the Network B router IP
address. Set the sampling frequency reception for any one of the NX-100 and NX-100S units connected to
Network B. Add the address translation of the unit set to receive the correction data to the Network B router. 
Note, however, that this setting is not needed when limited to use within the LAN*, because the sampling
frequency is automatically corrected. 

* Broadcast effective range
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1.8. How the Contact Bridge Works

1.8.1. Basic operation

Whenever any variation in the contact input occurs, the input change information is communicated to the
preprogrammed output destination.

Note: No information is communicated when the contact input remains unchanged.

NetworkNX-100/100SContact input ON Contact output ONNX-100/100S

Contact input Contact outputNetwork communication

Input ON

Output ON

ON

Control result: OK

1.8.2. Retry operation

If a failure of contact bridge control is detected, the system automatically attempts to reestablish control after a
5-second interval (retry operation). The retry operation continues until the contact bridge has been
successfully controlled or the contact input status has changed.

Contact input Contact outputNetwork communication

Input ON

5 s

Output ON

ON

Control result: NG

ON

Control result: NG

5 s

ON

Control result: OK

[Factors attributable to contact bridge
control failure]

• Contact input and output devices are not
recognized as existing in the same system.
(Their respective system names differ from
each other.)

• Contact output not set to standard mode. 
• Timeout or error occurs in network

communications. 



Contact input Contact outputNetwork communication

Input OFF

Power ON

Output OFF

OFF

Control result: OK
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1.8.3. Operation at system startup

When contact bridges are registered, the contact
input device transmits contact input status
information to the contact output device
immediately after power is switched ON. This
operation is performed for all registered contact
inputs.

Note
If a contact bridge output destination device is
not connected to the network or if the power is
OFF, the contact input device repeatedly
continues retry operation after power is switched
ON. Whenever control results in failure, the
ERROR indicator on the front panel lights for one
second.

1.8.4. Operation at power-off or power restoration

The following examples show the contact status changes from the status illustrated below when the control
input or output device's power is switched ON or OFF.

NetworkContact input deviceContact input ON Contact output ONContact output device

Power ON Power ON

[Operations caused by a change in the contact input device’s power status]

Contact input 
deviceContact input ON

ON

Contact output ON

ON

Contact output 
device

ON ON

Power OFF

Power ON

Network

(Transmits initial status 
 information when power 
 is switched ON.)

(Receives contact ON 
 information.)

(Holds current status in 
 the absence of changed 
 information.)

[Operations caused by a change in the contact output device’s power status]

Contact input 
deviceContact input ON

ON

Contact output ON

OFF

Contact output 
device

ON OFF

Power OFF

Power ON

Network

(Output turns OFF when 
 power is switched OFF.)

(No information is
 transmitted because no
 change is detected in
 the contact input device.
 Mismatching occurs
 between contact input
 and output statuses.)
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[Operations caused by a change in the contact input and output devices' power statuses]

Contact input 
deviceContact input ON

ON

Contact output ON

OFF

Contact output 
device

ON ON

Power OFF

Power ON

Power OFF

Power ON

Network

(Output turns OFF when
 power is switched OFF.)

(Receives contact ON 
 information.)

(Transmits initial status
 information when power
 is switched ON.)

1.8.5. Simultaneous control of multiple contact outputs

Simultaneously providing the contact bridge to multiple outputs in the same device may result in control failure
(see charts below). 
This can be avoided by shifting each control timing by 100 ms or more at the contact input side. Note that if
control fails, retry operation is automatically performed. 

Contact input device

ON
ON

ON

Contact output device

ON
ON

Possible failure to turn ON 

ON

Simultaneously 
timed controls

Simultaneously 
timed controls

Simultaneously 
timed controls

Simultaneously 
timed controls

ON
Possible failure to turn ON 

Contact input device

ON
ON

ON

Contact output device

ON
ON

Possible failure to turn ON 

ON
ON

Possible failure to turn ON 
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2. INDICATOR STATUS AND TROUBLESHOOTING

00-05-F9-FF-80-81

NETWORK AUDIO ADAPTER NX-100S

LNK/ACT FD/COL SIGNAL

INPUT

PEAK STATUS ERROR RUN RESET

1 2 3 4 5 6 7

This figure represents the NX-100S.

Indicator status: Lighting, Flashing, Off

1. LNK/ACT Indicator (Green)
Being network-connected
Transmitting or receiving data

2. FD/COL Indicator (Yellow)
In full-duplex communications
Data collision occurrence
In half-duplex communications with the unit
network-connected

3. Input Signal Indicator (Green) 
Audio signal level high enough for network
transmission

4. Input Peak Indicator (Red) 
Audio signal distorted
Audio signal reaching clipping level

5. Status Indicator (Yellow)
Broadcasting
Writing data, updating firmware, or data write
failure

6. Error Indicator (Red)
Firmware exception handling
Communications error (on for 1 s, then off)

7. Run Indicator (Green)
CPU normal operation
CPU malfunction

NX-100S only

NX-100S only

[Normal indicator status]

Description

Continues for 30 seconds after the 
unit is turned on.
If this status remains unchanged over 
30 seconds, this shows unit failure.
Contact your TOA dealer.

Normal condition when broadcast is 
not performed.

Normal condition when broadcast is 
performed.

Automatically changes to the "Starting 
up" status above when the firmware 
update or data write ends. 
Note
Never restart nor turn off the unit in 
this condition, as doing so may cause 
the unit to fail.

Starting up 
(for 30 seconds)

No audio signals 
input and output

Audio signals input 
and output

Updating firmware

Writing data

Indicator
 statusUnit 

conditions

or or or

or or or

(Flashes 
 fast.)

or or

or or or

1 2 3 4 5 6 7

LNK/ACT FD/COL SIGNAL PEAK

(NX-100S only)

STATUS ERROR RUN

(Flashes in 
 1-second 
 cycles.)
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[Error indicator status]

Possible cause and remedy

Power off
AC adapter is disconnected.
→ Ensure the connection of power supply.

CPU error (CPU hang-up)
→ Contact your TOA dealer.

Data write error
Writing data failed because the unit's power is shut off or 
other trouble occurs during data write or firmware update.
→ Contact your TOA dealer.

Firmware exception handling occurrence
→ Push the front-mounted Reset button to restart the unit 

operation.
If this happens frequently, contact your TOA dealer.

Communications-related errors on network and control
Causes may be the following: Power-off or network 
disconnection of the unit set to be controlled, duplicate 
control (busy), NX-100/100S setting errors (impossible 
control or communications settings), and network 
equipment setting errors.
→ Establish a connection to the unit to be controlled, or 

change settings of individual equipment.

Packet collision occurrence
The NX-100/100S and the connected network equipment 
are in half-duplex communications, and collision occurs. 
This may cause intermittent sound when audio signals are 
transmitted.
→ It is preferable to use the NX-100/100S in full-duplex 

communications.

Network disconnection
LAN cable is disconnected or network equipment is turned 
off.
→ Ensure each connection to the network equipment.

Excessive audio signal input (Distorted output signal)

Audio signal level applied is excessively high.
→ Set the input volume control and the input level selection 

switch appropriately.  

(Flashes alternately.)

(Lights for 
 1 second 
 in several-
 second 
 cycles)

or

1 2 3 4 5 6 7

LNK/ACT FD/COL SIGNAL PEAK

(NX-100S only)

STATUS ERROR RUN

No audio signal input

If this happens though the Audio input terminal is 
connected to equipment, the cause may be the following 
case: the external equipment is turned off, or its 
connection cable is disconnected, or the NX-100S input 
volume control is fully turned down.
→ Ensure the connection and power of external equipment, 

and the NX-100S volume control adjustment.

NX-100S only

NX-100S only
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Remedy

Confirm that power is correctly connected.

Turn power on again. 

Confirm that LAN cable is correctly connected.

Confirm that the NX-100/100S is connected to the correct switching
hub's port and that the proper type of cable is used for the connection.

→ Refer to p. 2-3, Network Connections, for connections to other
networks.

Confirm that Java Runtime Environment is installed in PC using the
Setup/Operation programs. 

→ Refer to p. 2-9, Installing Java Runtime Environment, for correct
installation.

Check version number of installed Java Runtime Environment. Unit
may malfunction if version numbers differ. 

→ Refer to p. 2-9, Installing Java Runtime Environment, for
confirmation of the version number. 

Confirm that PC using Setup/Operation programs is correctly
connected to network. 

Confirm that unit's IP address, subnet mask, and default gateway are
correctly set. 

→ Refer to p. 3-8, Unit Scanning Tool, or p. 4-4, Network Setting, for
network setting procedures. 

When connected to other networks via router, confirm with network
management personnel if the router is properly set.

If Java Runtime Environment is set to operate via a proxy server,
indications may not be properly displayed. Cancel the use of proxy.
(Perform this operation from the Control Panel.)

Check PC using Setup/Operation programs by way of browser for
correct connection. Also, confirm that browser is correctly set.

Setting screen uses JavaScript. Confirm that browser is JavaScript-
compatible and that the function is set to Enable. 

Screen may not be properly displayed if browser is set to use a proxy
server. Do not use proxy server.

Check to see if correct type of cable is used.

Confirm that serial communication settings of both original and
connected units are correct. 

→ Refer to p. 3-27, Serial Bridge Setting, or p. 4-18, Serial Bridge
Setting, for serial communication setting. 

Confirm that connections are correctly made to equipment that meets
unit's control I/O specification requirements. 

3. IF A FAILURE IS DETECTED

Symptom

Cannot start up. No LEDs light.

LNK/ACT LED does not light.

Setup/Operation programs do not
start up. 

Setup/Operation programs cannot
recognize NX-100 unit.

Browser setting screen is not
properly displayed.

Control inputs and outputs do not
operate.

Cannot carry out communications
using RS-232C interface.

NX-100 only
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Remedy

Confirm that sound source equipment, amplifier, and speaker are
correctly connected.

Confirm that audio input volume control is properly adjusted.

Confirm that the rear-mounted input level selection switch is set to
appropriate position.

Check audio activation control input for correct setting. 

→ Refer to p. 3-23, Contact Setting, or p. 4-13, Contact Setting, for
control input activation.

Check to see if audio-related settings, such as sampling frequency
and compression, are correct.

→ Refer to p. 3-18, Broadcast Spec Setting, or p. 4-6, Broadcast
Spec Setting, for audio-related settings.

When hum noise is heard, unit's FG terminal may not be correctly
connected.

→ Check to see if it is correctly connected.

When short noises are heard or when audio output is lost, network
may be congested. Check log contents. If congestion is found,
consult with network management personnel.

→ Refer to p. 4-24, Stream Logs, to confirm log contents.

When broadcasts are heard mixed in multicast streaming, the same
multicast address may have been set for some broadcasts in
Broadcast Spec setting.

→ Avoid duplication of multicast address when performing settings
for system units. 

When other malfunctions occur, Error indicator may light.

→ Since serious failure may have occurred when Error indicator
lights, check log. Refer to p. 4-21, Operation Log, to confirm log
contents.

Incorrect settings, or NX-100 or NX-100S failure may be the cause. 

→ Refer to p. 5-15, Error Messages, for details. 

Contact TOA dealer. 

Symptom

Outputs no audio signal or
distorted signal.

Audio output is affected by noise
or lost.

Audio outputs are mixed.

Other malfunctions

Forgot password.

Error message is displayed during
operation using Operation program. 
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4. SPECIFICATIONS

4.1. NX-100

* 0 dB = 0.775 V

Note: The design and specifications are subject to change without notice for improvement. 

• Optional products
Rack mounting bracket: MB-15B-BK (for rack-mounting one NX-100 unit)

MB-15B-J (for rack-mounting two NX-100 units)

AC adapter: AD-246

Note: When you need the AC adapter, be sure to consult your TOA dealer.

Power Source 24 V DC (removable terminal block 3 pins) or 
AC adapter AD-246 (optional) or equivalent

Current Consumption 200 mA (DC operation)

Audio Input 1 channel (transformer-isolated), –58 to 0 dB*,
balanced (MIC/LINE changeable, volume adjustable with volume control),
2 kΩ, removable terminal block (3 pins)

Audio Output 1 channel (transformer-isolated), balanced, 10 kΩ, 
removable terminal block (3 pins)

Frequency Response 50 Hz – 14 kHz (when sampling frequency is 32 kHz)

Distortion Under 0.3% (1 kHz, when sampling frequency is 32 kHz)

Control Input 8 channels, no-voltage make contact input, open voltage: 12 V DC,
short-circuit current: 10 mA, removable terminal block (9 pins)

Control Output 8 channels, open collector output (polarized), withstand voltage: 30 V DC,
control current: 50 mA max., removable terminal block (9 pins)

Network I/F 10BASE-T/100BASE-TX, Auto-Negotiation

Serial I/F RS-232C (DCE I/F), D-sub connector (9P, male), 9600 – 115200 bps

Network Protocol TCP, UDP, ARP, ICMP, HTTP, RTP, IGMP

Audio Packet Unicast (Up to 4 simultaneous transmissions)
Transmission System Multicast (Up to 64 simultaneous transmissions)

Operating Temperature 0°C to +50°C (0°C to +40°C when AC adapter is in use)

Operating Humidity Under 90% RH (no dew condensation should be produced)

Finish Steel plate, black (30% glossy) 

Dimensions 210 (w) x 44.7 (h) x 188 (d) mm

Weight 1.2 kg
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* 0 dB = 0.775 V

Note: The design and specifications are subject to change without notice for improvement. 

• Optional products
Rack mounting bracket: MB-15B-BK (for rack-mounting one NX-100S unit)

MB-15B-J (for rack-mounting two NX-100S units)
AC adapter: AD-246

Note: When you need the AC adapter, be sure to consult your TOA dealer.

Power Source AC adapter AD-246 (optional) or equivalent

Power Consumption 7 W (when the optional AD-246 is used)

Audio Input 1 channel (transformer-isolated), –58 to 0 dB*,
balanced (MIC/LINE changeable, volume adjustable with volume control),
2 kΩ, removable terminal block (3 pins), 
phantom power supply (24 V, can be set with the switch)

Audio Output 1 channel (transformer-isolated), balanced, 10 kΩ, 

removable terminal block (3 pins)

Frequency Response 50 Hz – 14 kHz (when sampling frequency is 32 kHz)

Distortion Under 0.3% (1 kHz, when sampling frequency is 32 kHz)

Control Input 8 channels, no-voltage make contact input, open voltage: 12 V DC,
short-circuit current: 10 mA, removable terminal block (9 pins)

Control Output 8 channels, open collector output (polarized), withstand voltage: 30 V DC,
control current: 50 mA max., removable terminal block (9 pins) 

Network I/F 10BASE-T/100BASE-TX, Auto-Negotiation

Network Protocol TCP, UDP, ARP, ICMP, HTTP, RTP, IGMP

Audio Packet Unicast (Up to 4 simultaneous transmissions)
Transmission System Multicast (Up to 64 simultaneous transmissions)

Operating Temperature 0°C to +40°C

Operating Humidity Under 90% RH (no dew condensation should be produced)

Finish Steel plate, black (30% glossy) 

Dimensions 210 (w) x 44.7 (h) x 188 (d) mm

Weight 1.2 kg

4.2. NX-100S
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